THE MAPLE V PRIMER

Release 4

Frank Garvan
quitting, 7
rational, 9–10, 129–130
random matrices, random.mat. 90–97
rational, 10
rationalize the denominator, see rationals
reading a file, read. 104–107
readlib, 10–17, 52
reference books, 122–133
remainder, 30–21, 26–29
restoring variable status, 22
restricting domain and range, 65
return, 101
rotate, 25
rotation of a surface, 85
row echelon form, 93
row operations, swape, swapping, addrow, 90–91
row space, rowspace, 94
same cube, 60, 75, see constrained
saving a maple session, 106–109
saving a plot, 72–73
saving variables, save, 106
semi-colon, 3
seq, 32, 36, 42, 130
sequences, 31–33
ser. 61, see Taylor series
set operations, 34
sets, 33–35
simplifying
expressions, simplify, 14–15, 130
radical, see radical, rationals
solving
equations, solve, 23–25, 131, see fsolve, isolate
solving
rational functions, see normal, simplify
space curve, spacecurve, 79
square root function, sqrt, 8, 13
starting a session, 1
statistical plotting, 119
statistics package, stats, 119
Student calculus package, student, 116–120
substituting, into an expression, subs, 22, 90, 53, 131
Sun, sun, 65–64, 131
tables, table, 36–37
Taylor series, taylor, 80–81, 132
text in a plot, textplot, 70–71
title in a plot, 70, 82–83
toolbar, 1
trace of a matrix, 89
transpose of a matrix, 89
type, 90–91
unapply, 41
union, 34
values, 44, 90–98, 54–58, 132
vector, 86
verbform, 105
6. Graphics

1. 2-dimensional plotting
2. 3-dimensional plotting
3. Multiple plots
4. Polar plots
5. Plotting implicit functions
6. Plotting points
7. Title and text in a plot
8. Plotting options
9. Saving and printing a plot

7. Linear Algebra

1. Vectors, arrays, and matrices
2. Matrix operations
3. Elementary row operations
4. Gaussian elimination
5. Inverses and determinants
6. Row space, column space, nullspace
7. Eigenvalues and diagonalization
8. Jordan form ................................................................. 96
9. Random matrices .......................................................... 96
10. More linear functions ...................................................... 97
8. MAPLE V Programming .................................................. 98
  1. Conditional statements ............................................... 99
  2. Loops ........................................................................ 99
  3. Procedures ................................................................. 101
  4. Local and global variables ............................................. 103
  5. Reading and saving proc's ............................................ 104
  6. Viewing built-in MAPLE V code ..................................... 105
9. Saving and reading files .................................................. 105
  1. Saving a Maple session ................................................ 105
  2. Reading MAPLE V programs ......................................... 106
  3. Saving worksheets and LATEX ....................................... 107
10. Document preparation .................................................. 107
  1. Adding text .................................................................. 109
  2. Inserting math into text ................................................. 110
  3. Adding titles and headings ............................................ 110
  4. Creating a subsection ................................................ 111
  5. Cutting and pasting ..................................................... 112
  6. Bookmarks and hypertext .............................................. 115
11. Overview of Packages .................................................. 116
  1. Numerical approximations .......................................... 116
  2. Combinatorial functions ............................................. 117
  3. Number Theory .......................................................... 117
  4. Orthogonal polynomials .............................................. 118
  5. Statistics .................................................................. 119
  6. Student calculus ......................................................... 119
  7. Other packages .......................................................... 120
12. Glossary of commands .................................................. 121
13. Further reading ........................................................... 132
Index .............................................................................. 135
EXAMPLE:
> radsimp(sqrt(3)*sqrt(15));

\texttt{radsimp} Rationalize the denominator
SYNTAX: \texttt{radsimp}(\texttt{expr})
Rationalize the denominator in the expression.
EXAMPLE:
> (\texttt{1+sqrt(2)})/(\texttt{sqrt(2)}-\texttt{sqrt(3)}):
\texttt{radsimp}(\texttt{""});

\texttt{rhs} \quad \text{Right-hand side of an equation}
SYNTAX: \texttt{rhs}(\texttt{eqn})
Gives the right-hand side of the given equation.
EXAMPLE:
> a:=x^2+y^2+z^2: \texttt{rhs}(a);

\texttt{seq} \quad \text{Creates a sequence}
SYNTAX: \texttt{seq}(\texttt{f(i), i=a..b})
This creates the sequence \(f(a), f(a+1), \ldots, f(b)\).
EXAMPLE:
> \texttt{seq}(x^2+(y-x)*i/4, i=0..4);

\texttt{simplify} \quad \text{Simplify an expression}
SYNTAX: \texttt{simplify}(\texttt{expr})
Simplifies the expression.
EXAMPLE:
> \texttt{simplify}((\texttt{sin(x)}+\texttt{cos(x)})^2);

\texttt{solve} \quad \text{Solve equations}
SYNTAX: \texttt{solve}(\texttt{eqns, var})
Finds solutions to the given set of equations (if they exist).
EXAMPLE:
> \texttt{solve}([x^2+y^2-x^2=17, y^2-x^2-y^9], \{x, y\});

\texttt{spacecurve} \quad \text{Plot spacecurve}
SYNTAX: \texttt{spacecurve}([f(t), g(t), h(t)],
\quad t=a..b)
Plots the space-curve parametrized by \(x = f(t), y = g(t), z = h(t), a \leq t \leq b\).
EXAMPLE:
> \texttt{spacecurve}([\texttt{sin}(t), \texttt{cos}(t), \texttt{t}, \texttt{t=0..2*Pi}]);

> 105/26;
\texttt{syntax error, unexpected number}

Don't panic! \texttt{Maple} v has interpreted this to mean 105/25 105/25 hence the syntax error. \texttt{Maple} v also gave a warning about the missing semi-colon! If you forget the semi-colon, simply type it on the next line.
> 105/25
> 
21/5

See section 1.3 for a method for editing mistakes.
Results can be assigned to variables using the colon-equals "::".

> f::=

\[ f := 21/5 \]
> G:= -1/5;
\[ G := -1/5 \]
> f*G;
\[ 21/5 + g \]
> \# observe that Maple is case sensitive.
> f+G;
\[ 4 \]

Note that comment lines begin with \#.

1.3 \quad \textbf{Editing mistakes}

\texttt{Maple} v has built-in editing facilities. On most platforms, lines of input can be edited using the arrow keys and the mouse. Cutting and pasting is also possible with the mouse. In the Windows version, you can select input by highlighting with the mouse, then you can copy, cut, and paste by using \texttt{control-c}, \texttt{c}, and \texttt{v} as usual. In the command-line (or ttyp) version, \texttt{Maple} v has two built-in editors: \texttt{emacs} and \texttt{vi}. Use the help command \texttt{?editing} for more information.
> 105/26
> 105/26;
\texttt{syntax error, unexpected number}

Just click the mouse after 105/25, enter a semi-colon, and press enter.
> 105/26;
\[ 21/5 \]

The \texttt{vi} editor can be invoked using the \texttt{Esc} key.

3
1.4 Help

In Maple V (Release 4) there is a fabulous interactive help facility. Click on Help and select Full Text Search... A little window should appear. In the Words box, type floating point then click on Search. A search is then made of the interactive help manual. A list of topics should appear in the Matching Topics box. Select evalf with the mouse, then click on Apply. A help window should appear with information on the evalf command.

If you know the name of a command, then you can select Topic Search... in the Help window. Help can also be accessed directly from the worksheet. Try

> ?evalf

The evalf help window should appear. In the tty version, this information will appear below the cursor.

Now try selecting Balloon Help in the Help menu. Next move the cursor onto a button and a little bubble should appear giving a brief description. Keep this option until you are familiar with the buttons and menus.

The command ?index provides a list of categories: expression, function, misc., etc. For instance, ?index[functions] gives a list of Maple V's standard library functions. For more information on navigating through the worksheet environment, see Worksheet Help.

1.5 Quitting Maple V

If you are done with your Maple V session click on . The Save As window should appear. In the File Name box type ch1.txt and click on OK. Your worksheet has now been saved. To quit Maple, go to the File menu and select Exit. Later you can reopen your worksheet by clicking on .

In the tty version, the easiest way to quit a Maple session is to use quit.

> quit

2. Maple V as a Calculator

2.1 Exact arithmetic and basic functions

As we noted in Section 1.2, Maple V does exact arithmetic. Also, Maple V does integer arithmetic to infinite precision. Try the following examples:

> 2/3 + 3/5;
19
15

> 7 - 11/15;
94
15
4

Syntax: numden(expr)
Returns the numerator of the expression.
Example:
> numden((x*sin(x) - cos(x))/x^2);

Syntax: op(expr)
Extracts operands of an expression.
Example:
> w:=x^3+x*y: op(w); op(2,w);

plot 2-dimensional plot of a function

Syntax:
> plot(f(x),x=a..b);

Plot the function y = f(x), a ≤ x ≤ b.
Example:
> plot(x*sin(x),x=0..Pi);

plot3d 3-dimensional plot of a function

Syntax:
> plot3d(f(x,y),x=a..b,y=c..d);

Plot the function z = f(x,y), a ≤ x ≤ b, c ≤ y ≤ d.
Example:
> plot3d(sin(x*y),x=0..Pi,y=0..Pi);

polarplot Plots a polar curve

Syntax:
> polarplot(f(t),t=a..b);

Plots the polar curve r = f(θ), a ≤ θ ≤ b.
Example:
> with(plots);
polarplot(sin(t),t=0..2*Pi);

product Find the product

Syntax:
> product(i=i..b);
Computes the product

Example:
> product((a+i-1),i=1..6);

radsimp Simplify radicals

Syntax:
> radsimp(expr);
Simplify the expression containing radicals.
3.1.1 Factoring a polynomial

Maple v can do high school algebra. It can manipulate polynomials and rational functions of one or more variables quite easily.

```maple
> p := x^2 + 5x + 6;
> factor(p);
(x + 3)(x + 2)

> b := 1 - q^7 - q^8 - q^9 + q^{15} + q^{16} + q^{17} - q^{24};
> factor(b);
```

To factor a polynomial or rational function we use `factor`. We let \( p = x^2 + 5x + 6 \) and found the factorization using `factor(p)`. This could have easily been done by hand. Factoring \( b = 1 - q^7 - q^8 - q^9 + q^{15} + q^{16} + q^{17} - q^{24} \) is not so easy, but child's play for `Maple v`.

3.1.2 Expanding an expression

To expand a polynomial use `expand`. The command `combine` is also useful for expanding certain expressions.

```maple
> p := (x+2)*(x+3);
> expand(p);
(x + 2)(x + 3)

> b := (1-q^8)*(1-q^7)*(1-q^6);
> expand(b);
```

74
Notice we were not able to expand the expression \((x + 1)^{1/2}(x + 3)^{1/2}\) with \texttt{expand} and had to use \texttt{combine} instead.

### 3.1.3 Collecting like terms

The \texttt{collect} function is useful when looking at a polynomial in more than one variable.

\[
(x + y + 1)(x - y + 1)(x - y - 1)
\]

\[
p := \text{expand}(\ast);
\]

\[
p := x^3 - x^2 y + x^2 - 2 xy - x - y^2 x + y^2 + y^2 - y - 1
\]

\[
collect(p, x);
\]

\[
x^3 + (1 - y)x^2 + (-1 - y^2 - 2 y)x - y - 1 + y^3 + y^2
\]

We let \(p = (x + y + 1)(x - y + 1)(x - y - 1) = x^3 - x^2 y + x^2 - 2 xy - x - y^2 x + y^2 + y^2 - y - 1\). We used \texttt{collect}(p, x) to write \(p\) as a polynomial in \(x\) with coefficients that were polynomials in the remaining variable \(y\). Similarly, try \texttt{collect}(p, y) to get \(p\) as a polynomial in \(y\).

### 3.1.4 Simplifying an expression

The first thing you should try when presented with a complicated expression is \texttt{simplify}.

\[
3*4^{\ast}(1/2)*5;
\]

\[
3 \sqrt{4} + 5
\]

\[
simplify(\ast);
\]

\[
11
\]

\[
x^\ast2;
\]

\[
x^2
\]

\[
"^\ast(1/2);
\]

\[
\sqrt{x^2}
\]

\[
simplify(\ast);
\]

\[
csgn(x)\times
\]

Notice we were able to simplify \(3 \sqrt{4} + 5\) to 11. Of course, the value of \((-2)^{1/2}\) depends on the sign of \(x\). Here \texttt{csgn} is a function that returns 1 if \(x\) is positive and \(-1\) otherwise. If we knew that \(x > 0\), we can use \texttt{assume} to do further simplification (\(x^\ast\) replaces \(x\)).

\[
\sqrt{x^2 + 5x + 6}
\]

\[
\text{changevar} \quad \text{Performs a substitution in an integral}
\]

\[
\text{syntax: } \text{changevar}(\omega=g(x), \int (f(x), x), u)
\]

Performs the substitution \(u = g(x)\) on the given integral.

\[
\text{example: } > \text{with}([\text{student}]); \quad \text{Int}(x^\ast2/\sqrt{1-x^\ast6}, x);
\]

\[
\text{changevar}(\omega=x^\ast3, \ast, u);
\]

\[
\text{coeff} \quad \text{Coefficient in a polynomial}
\]

\[
\text{syntax: } \text{coeff}(p(x), x, k)
\]

Returns the coefficient of \(x^k\) in the polynomial \(p(x)\).

\[
\text{example: } > \text{expand}((1+x+x^\ast2)^\ast10); \quad \text{coeff}(\ast, x, 10);
\]

\[
\text{collect} \quad \text{Collect coefficients of like powers}
\]

\[
\text{syntax: } \text{collect}(\text{expr}, x)
\]

Write the expression as a polynomial in \(x\).

\[
\text{example: } > (x+1)^\ast3*y-(y+1)^\ast3*x; \quad \text{collect}(\ast, x);
\]

\[
\text{combine} \quad \text{Combine terms}
\]

\[
\text{syntax: } \text{combine}(\text{expr})
\]

Combines terms in the expression.

\[
\text{example: } > \text{combine}((\sqrt{x+2})*\sqrt{x+3});
\]

\[
\text{contourplot} \quad \text{2-dimensional contour plot}
\]

\[
\text{syntax: } \text{contourplot}(f(x,y), x=a..b, y=c..d)
\]

Produces level curves of the function \(f(x,y)\) with \(x, y\) in the specified ranges.

\[
\text{example: } > \text{with}([\text{plots}]); \quad \text{contourplot}(\sin(x+y), x=0..\Pi, y=0..\Pi);
\]

\[
\text{convert} \quad \text{Convert data type}
\]

\[
\text{syntax: } \text{convert}(\text{expr}, \text{type})
\]

Converts the expression to the new type.

\[
\text{example: } > \text{series}(\sqrt{1-x}, x, 4); \quad \text{convert}(\ast, \text{polynom});
\]
divisors  set of divisors
factor set  set of prime divisors
cfrac  continued fraction expansion
cyclotomic  cyclotomic polynomial
cj  Jacobi symbol
kronecker  inhom. Diophantine approx.
legers  Legendre symbol
mcombine  Chinese remainder theorem
minkowski  hom. Diophantine approx.
phi  Euler phi-function
prmroot  primitive root
sigma  sum of divisors
sum2sqr  sum of two squares
tau  number of positive divisors

11.4 Orthogonal polynomials

The orthogonal polynomial package is orthopoly.

\[ G(n \alpha, x) \]  Gegenbauer polynomial
\[ \Pi(n, x) \]  Hermite polynomial
\[ \Phi(n, x) \]  Laguerre polynomial
\[ \Pi(n, a, x) \]  generalized Laguerre polynomial
\[ P(n, x) \]  Legendre polynomial
\[ P(n, a, b, x) \]  Jacobi polynomial
\[ T(n, x) \]  Chebyshev polynomial (first kind)
\[ U(n, x) \]  Chebyshev polynomial (second kind)

11.5 Statistics

The stats package has seven subpackages:

anova  analysis of variance
describe  data analysis
fit  linear regression
random  random numbers with a given distribution
statepdf  numerical evaluation of distribution function
statplots  statistical plotting
transform  data manipulation

The following function is available at the top level.

\[ \text{factor}(c); \]
\[ \frac{x + y + z}{(x^2 - y x + x z - y z)(-x + y + z)} \]

\[ \text{numerator}(c); \]
\[ -(x + y + z)(x + y + z) \]

\[ \text{denominator}(c); \]
\[ (x^2 - 2x y - 2x + y^2 + 2y z + x^2)(x^2 - x y + x z - y z) \]

\[ \text{factor}(|n|); \]
\[ (x + y + z)^2(x - y)(x + z) \]

Observe that \text{numerator} and \text{denominator} had the same effect on the rational function \( c \). We use \text{factor} for rational functions if we can do without the more expensive \text{factor}. Also, we could have used \text{factor} to simplify \( c \) and get it into a nice form. It should be noted that \text{factor} is able to do this simplification without factoring, which is more expensive.

Some useful functions for manipulating rational functions are: \text{numerator}, \text{denominator}, \text{gcd}, and \text{quo}. We let \( c \) be as above.

\[ \text{factor}(\text{gcd}(c)); \]
\[ (x - y)(x + y + z) \]

\[ \text{factor}(\text{quo}(a, b)); \]
\[ \frac{a}{b} \]

The functions \text{numerator} and \text{denominator} select the numerator and denominator, respectively, of a rational function. After factoring the denominator of \( c \), we see that there was simplification because of the common factor \(-x + y + z\).

The functions \text{quo} and \text{rem} give the quotient and remainder upon polynomial division.

\[ a := 2 x^3 + 3 x^2 + 12; \]
\[ a := 2 x^3 + x^2 + 12 \]

\[ b := x^3 - 4; \]
\[ b := x^3 - 4 \]

\[ q := \text{quo}(a, b, x); \]
\[ q := 2 x + 1 \]

\[ r := \text{rem}(a, b, x); \]
\[ r := 16 + 8 x \]

\[ \text{expand}(a - (b \cdot q + r)); \]
\[ 0 \]

The command \text{quo}(a, b, x) gives the quotient \( q \) when \( a \) is divided by \( b \) as polynomials in \( x \). The command \text{rem}(a, b, x) gives the remainder \( r \) so that

\[ a = bq + r, \]
and the degree of $r$ (as a polynomial in $x$) is less than the degree of $b$.

3.1.7 Coefficients of a polynomial

In Section 3.1.3 the collect command was introduced to view polynomials. Two other useful functions are `coeff` and `degree`. Let $p$ be as before.

```latex
\begin{verbatim}
> p := (x+y+z)*(x-y+z)*(x-z+z);
  p := (x + y + z)(x - y + z)(x - y - z)

> coeff(p, x, 2);
  -y + 1

> coeff(p, x, 2);
  0

> degree(p, x);
  3
\end{verbatim}
```

The command `coeff(p, x, 2)` found the coefficient of $x^2$ in the polynomial $p$. The command `degree(p, x)` gave the degree of $p$ as a polynomial in $x$. Observe also that when `coeff` was applied to the expanded form $p$, an "incorrect" value of 0 was returned. Be careful.

3.1.8 Substituting into an expression

We may substitute into an expression using the command `subs`.

```latex
\begin{verbatim}
> p := (x+y+z)*(x-y+z)*(x-z+z);
  p := (x + y + z)(x - y + z)(x - y - z)

> subs(x=1, p);
  (1 + y + z)(1 - y + z)(1 - y - z)

> subs(x=1, y=2, p);
  (3 + z)(-1 + z)(-1 - z)
\end{verbatim}
```

To substitute $x = 1$ into $p$, we used the command `subs(x=1, p)`. Try substituting $x = 1$ and $y = 2$ into $p$ using the command `subs(x=1, y=2, p)`,

3.1.9 Restoring variable status

In the last section we saw how `subs` is used to do substitution. There is another way to do this. We let $p$ be as `Section 3.1.8`.

```latex
\begin{verbatim}
> p;

> x := 1;

> y := 2;

> p;
  (3 + z)(-1 + z)(-1 - z)
\end{verbatim}
```

We are able to do the substitution by assigning $x := 1$ and $y := 2$. However, now $p$ has changed. There is a way to restore $x$ and $y$'s variable status.

(or type `ANSWER` in the box). Finally, click on `OK`. The worksheet should now contain a green `diameter`. You will need to delete the old "diameter". Try clicking on `diameter`. The cursor should move to the last equation in the worksheet where we placed the bookmark `ANSWER`.

Try adding a hyperlink to a different worksheet. First create a new worksheet say `shell.mws`, which contains a description of the shell method. Then attach a hyperlink to the phrase "shell method" in the original worksheet.

11. Overview of Packages

In Chapters 6 and 7 we needed the `plots` and `linalg` packages. In this chapter we give a brief description of the main functions in some of the other packages. Remember, a package must be loaded with the `with` command. To see a list of the available packages try

```latex
\begin{verbatim}
> ?index[packages]
\end{verbatim}
```

11.1 Numerical approximation

The numerical approximation package is `numapprox`. Remember to first type `with(numapprox):`

Functions include `chebyshev`, `Chebyshev expansion`
`hornerform`, `convert into Horner form`
`infnorm`, `L-infinity norm`
`minimax`, `best minimax rational approx.`
`pade`, `Pade approximation`

11.2 Combinatorial functions

The combinatorial functions are in the `combinat` package. Functions include

`character`, `character table of $S_n$`
`choose`, `subsets`
`graycode`, `graycode order`
`multinomial`, `multinomial coefficient`
`partition`, `partitions of a given integer`
`permute`, `permutations`
`random`, `random permutation`
`stirling1`, `stirling number of the first kind`

11.3 Number Theory

The number theory package is `numtheory`. Functions include:

`bernoulli`, `Bernoulli numbers and polynomials`
In the Insert menu, select Math Input and a red $\int$ should appear. Type
\[ \text{Int}(4\pi x^2 \sqrt{1-x^2}, x=0..r) \]
What was maple input should now appear as math in your document. Click to the right of the math and click on $\int$ and type
We compute the integral
Let's add a title.

10.3 Adding titles and headings

Click on the first line of the worksheet. In the Insert menu, select Execution Group and before Cursor. Then click on $\int$ In the box $\int$ Romain 2 select Title. Now type
The Ball Bearing Problem
The document should now have a title. Press enter and type your name
William E. Wilson
Your name should now be underneath the title. Press enter again. To make a heading this way, we select Heading 2. Type
Statement of the problem
To underline this heading, click on $\int$. Now make a heading entitled Solution for the next paragraph.
Let's move some of the maple computations into a new subsection.

10.4 Creating a subsection

Use the first mouse button to highlight the maple inputs
\[ v := \text{Int}(4\pi x^2 \sqrt{1-x^2}, x=0..r) \]
and
\[ v := \text{value}(v) \]
Together with their output. Now click on $\int$. A little button $\int$ should appear. Try clicking on it. Pretty neat! Now see if you can add a heading to this subsection using the Heading 3 selection.

Now we shall add some more text and math by cutting and pasting.

10.5 Cutting and pasting

\[ \text{polyeq} := Z^8+3Z^4-12+Z^3-36+Z^2+42+Z^2+0; \]
\[ a1 := \text{fsolve}(\text{polyeq}, Z); \]
\[ a1 := -3.136896207 \]
\[ x1 := a1^2 - 7; \]
\[ x1 := 2.840117813 \]
\[ \text{subs}([Z=x1, X=a1], \{\text{eqn1, eqn2}\}); \]
\[ \{14.00000000 = 14, 7.000000000 = 7\} \]
We used the command fsolve(polyeq, Z) to find the approximate solution $Z \approx -3.136896207$. This implies that $a = -3.136896207$ and $x = a^2 - 7 = 2.840117813$ are approximate solutions to our system of equations in the previous section. We were able to check this using subs.

3.2.4 Assigning solutions

Once an equation or system of equations has been solved, we can use assign to assign a particular solution to the variable(s). We use the example given in Section 3.2.2.
\[ \text{solve}([Z^3+3Z^2-14, a^2-x-7], \{a, x\}); \]
\[ "[1]; \]
\[ \{a = 3, x = 2\} \]
\[ \text{assign}(); \]
\[ a, x; \]
\[ 3\]
\[ 2\]

3.3 Fun with integers

3.3.1 Complete integer factorization

The command ifactor gives the prime factorization of an integer.
\[ 2^2 (2^3-5) + 1; \]
\[ 4294967297 \]
\[ \text{ifactor}(); \]
\[ (641) (6700417) \]
3.3.2 Quotient and remainder

The integer analogs of quo and rem, the functions for finding the quotient and the remainder in polynomial division, are the functions iquo and irem. They work in the same way.

> a := 23;  b := 5;

\[
a := 23
\]
\[
b := 5
\]

> q := iquo(a, b);  r := irem(a, b);

\[
q := 4
\]
\[
r := 3
\]

> b*q+r;

\[
23
\]

We observe that if \( q = \text{iquo}(a,b) \) and \( r = \text{irem}(a,b) \), then

\[
a = bq + r,
\]

where \( 0 \leq r < b \) if \( a \) and \( b \) are positive.

Two related functions are floor and frac. floor(x) gives the greatest integer less than or equal to \( x \) and frac(x) gives the fractional part of \( x \). Try

> x := 22/7;
> floor(x);
> frac(x);
> floor(-x);
> frac(-x);

3.3.3 Gcd and lcm

The greatest common divisor and the lowest common multiple of a set of numbers can be found using gcd and lcm.

> gcd(28743, 552805);

\[
11
\]

16

> \texttt{RRS}:=\texttt{solve}(w=2*Pi/3, r);

\[
\texttt{RRS}:=\texttt{RootOf}(-12z^4 + 12z^2 - 3 + 4z^6, -0.6883087005, \texttt{RootOf}(-12z^4 + 12z^2 - 3 + 4z^6, 0.6883087005))
\]

> \texttt{convert(\texttt{RRS}[2]\texttt{,radical});}

\[
\frac{1}{2} \sqrt{4 - 2^{1/3}}
\]

> \texttt{radimp(\texttt{\*2});}

\[
\sqrt{2} \sqrt{4 - 2^{1/3}}
\]

> \texttt{evalf(\texttt{\*});}

\[
1.2116617400
\]

The desired diameter is

\[
2r = \sqrt{2} \sqrt{4 - 2^{1/3}} \approx 1.212 \text{ cm.}
\]

You may be wondering what is going on in this problem. We can make a much clearer document by adding text.

10.1 Adding text

First we add some text to our document. Click the cursor on the first line of Maple input. Then in the Insert menu, select Expression Group and Before Cursor. A maple prompt > should appear above the first line of input. Now click on \( \text{Insert} \) and type

Reduce the volume of a ball bearing with diameter 2 cm by 50% by drilling a hole through the center. Determine the diameter of the required drill-bit.

To create a new paragraph, click on \( \text{Insert} \) and then \( \text{New} \). Now type

First we observe that the ball bearing is the solid obtained by rotating a circle of radius 1cm about the y-axis. If we let \( r \) be the radius of the drill-bit, then, by the shell method, the volume of material removed is given by

Now we would like to add some in-line math.

10.2 Inserting math into text
8.4 Local and global variables

If the local statement is not used in a Maple V proc, then all variables within the proc are declared local by default. To change the default we use the local and global statements.

> f := proc(x) x + 1; end;
> trap(f,1,2,10);
> trap(f,1,2,100);

8.5 Reading and saving procs

Although the editing features of Maple V are getting better and better with each release, it is usually more convenient and wise to write Maple V programs using an editor and save them in ordinary text files. For instance, instead of typing the proc `trap` (given in Section 8.3) directly into a worksheet within Maple, it would be better to create it using an editor on, say, the file `trap`. The Maple V read function is used to read a file into a Maple session. We give an example for Windows. If this file was in the sub-directory `myprog` within the `maple` directory, try

> read `c:\maple4\myprog\trap`;

and then `trap` is ready for use. A variant of this should work on other platforms. For instance, in the `unix` version try

op(expr) produces a sequence whose elements are the operands in expr.
> nops(L);
   4
> op(3,L);
   2c

nops(expr) gives the length of the sequence op(expr) and op(j,expr) gives the j-th term in the sequence op(expr).

If s is a sequence, then the j-th term of the sequence is s[j];
> s := 1, 8, 27, 64, 125;
   s := 1, 8, 27, 64, 125
> s[3];
   27

4.2 Sets

We have already seen the set data type in Section 3.2.2 when solving systems of equations. In Maple V, a set takes the form

\{expr1, expr2, expr3, ..., exprn\}.

In other words, a set has the form \{S\} where S is a sequence. A set is a set in the mathematical sense — order is not important.
> y := \{x, y, z\};
   \{x, y, z\}

Observe that \{x, y, z\} = \{x, y, z\}. Maple V can perform the usual set operations: union, intersection, and difference.
> a := \{1, 2, 3, 4\}; b := \{2, 4, 6, 8\};
   a := \{1, 2, 3, 4\}
   b := \{2, 4, 6, 8\}
> a union b;
   \{1, 2, 3, 4, 6, 8\}
> a intersect b;
   \{2, 4\}
> a minus b;
   \{1, 3\}

We can also determine whether a given expression is an element of a set using the function member.

> member(2, a);
   true

> member(5, a);
   false

> a[3];
   3

So member(x, A) returns the value true if \( x \) is an element of \( A \) and false otherwise. Also, the \( j \)-th element of the set \( A \) is \( A[j] \).

4.3 Lists

In Maple, a list takes the form

\[ [expr_1, expr_2, expr_3, \ldots, expr_n] \]

Here order is important.

> a := 'a';  b := 'b';
> L1 := [x, y, z, y]; L2 := [a, b, c];
   L1 := [x, y, z, y]
   L2 := [a, b, c]

> L := [op(L1), op(L2)];
   L := [x, y, z, y, a, b, c]

> L[5];
   a

We observe that the lists \( L1 \) and \( L2 \) can be concatenated by the command \([\text{op}(L1), \text{op}(L2)]\) and that \( L[j] \) gives the \( j \)-th item in the list \( L \). Lists can be created from sequences:

> s := seq(i/(i+1), i=1..6);
   s := 1/2, 2/3, 3/4, 4/5, 5/6, 6/7

> M := [a];
   M := [a]

f := proc(x) local i; if 0 <= x and x <= 1 then s := x^2 else := 1-x fi; RETURN(s) end

The input of the procedure (or function) \( f \) is a number \( x \). Using a conditional statement, we were able to define the function

\[ f(x) = \begin{cases} x^2 & \text{if } 0 \leq x \leq 1, \\ 1-x & \text{otherwise}. \end{cases} \]

We check that the function works.

> f(1/2);
   1

> f(2);
   -1

Now try plotting the function.

> plot(f, -2..2);

Remember this syntax. When \( f \) is a proc, the command \texttt{plot}(f(x), x=-2..2) will not work.

We now examine a more complicated example. The following procedure \texttt{trap}(f, a, b, n) computes an approximation of the definite integral \( \int_a^b f(x) \, dx \) using the trapezoidal rule with \( n \) divisions. Type it in.

> trap:=proc(f, a, b, n)
> local s, i, ds, exact, x;
> s := 0;
> for i from 1 to n-1 do
> s := s + f(a + i*b/a)/2;
> od;
> s := 2*s + f(a) + f(b);
> ds := (b-a)/2/n:
> exact := int(f(x), x=a..b);
> print(`The integral by the trapezoidal rule with n'=n, 'is'` );
> print(evalf(ds));
> print(`The exact integral is ',
> evalf(exact));
> print(`Error'= evalf(abs(ds-exact)));
> RETURN(evalf(ds));
> end:

Adding print statements is very handy for debugging a program. To compute the integral \( \int_a^b f(x) \, dx \) using the trapezoidal rule, try
Can you see why the matrix $F^{-1}$ must have integer entries?

7.10 More linear functions

- augment: augmented matrix
- backsub: back substitution
- blockmatrix: block matrix
- charmat: characteristic matrix
- cond: condition number
- copyinto: copies a matrix into another
- crossprod: cross product of two vectors
- curl: curl of a vector field
- diag: diagonal matrix
- diverge: divergence of a vector field
- dotprod: dot product of two vectors
- gensys: generate system of equations
- genmatrix: generate augmented matrix
- grad: gradient of a function
- GramSchmidt: Gram-Schmidt orthogonal process
- innerprod: inner product $u^T A v$
- jacobian: Jacobian matrix
- JordanBlock: Jordan block matrix
- leastsqr: least square problem
- linsolve: solve a linear system
- LDLcomp: $LDL^T$-decomposition
- matadd: compute a matrix sum
- minpoly: minimal polynomial of a matrix
- pivot: pivot a matrix
- potential: potential function
- QLDecomp: $Q R$-decomposition of a matrix
- rowdim: number of rows
- singularvals: singular values of a matrix
- stack: stacks two matrices
- submatrix: extract a submatrix
- vecpotential: vector potential of a vector field
- wronskian: Wronskian matrix

8. MAPLE V PROGRAMMING

MAPLE V is a programming language as well as an interactive symbolic calculator. It is possible to solely use MAPLE V interactively and not bother with its programming features. However, it is well worth the effort in developing some programming skills. The MAPLE V language is much easier to learn than the traditional programming languages and you

> L := [1, 2, 3] ;
> T := table([1, 2, 3]) ;
> M := array(1..3, [1, 2, 3]) ;
> type(L, list); 
true
> type(T, set); 
false

The function convert can be used to convert from one data type to the other.

> convert(A, list); 
[1, 2, 3]
> convert(L, set); 
[1, 2, 3]

Try using the function whattype. See whattype for help.

5. CALCULUS

5.1 Defining functions

To enter the function $f(x) = x^2 - 3x + 5$, type

> f := x -> x^2 - 3*x + 5;

The arrow symbol is entered by typing the minus key — immediately followed by the greater than key >. We compute $f(2)$.

> f(2);

3

Thus, in MAPLE V the syntax for creating a function $f(x)$ is $f := x \rightarrow \text{expr}$, where expr is some expression involving $x$. Functions in more than one variable are defined in the same way.

> g := (x, y) -> x*y/(1+x^2+y^2)

We defined the function

$$ g(x, y) = \frac{xy}{1 + x^2 + y^2} $$

Try simplifying $g(\sin t, \cos t)$
> g(sin(t), cos(t));
> simplify(";)

To convert an expression into a function, we use the unapply function.

> q := Z^5 + Z^4 - 12 Z^3 - 35 Z^2 + 42 Z + 119;

In Sections 3.2 and 3.3 we came across the quintic polynomial $q$ above. Here $q$ is an expression involving $Z$. To convert $q$ into the function $h(Z)$, we used the command unapply($q$, Z). Now we are free to play with the function $h$.

> H := x -> evalf(h(x), 4):

$H$ := $x$ -> evalf($h(x)$, 4)

$X$ := seq(evalf(4+i/10, 4), i=-10..10);

$X$ := $[-4.0000, -3.9000, -3.8000, -3.7000, -3.6000,$

> Y := map(H, X);

$Y$ := $[97.7374, 54.1596, -26.6171, -13.0517, -1.4326, 7.1242]$

The function $H(x)$ computes $h(x)$ to 4 digits. Then we used seq and map to produce the lists $X$ and $Y$ which give a table of $x$ and $y$ values for the function $y = h(x)$.

# 5.2 Composition of functions

In Maple, $\circ$ is the function composition operator. If $f$ and $g$ are functions, then the composition of $f$ and $g$, $f \circ g(x) = f(g(x))$, is given by $(\circ g)(x)$.

> (sin@cos)(x);

$\sin(\cos(x))$

> f := x -> x^2;

$\sin(\cos(x))$

> g := x -> sqrt(1-x);

$\sin(\cos(x))$

> (f@g)(x);

$\sin(\cos(x))$

> (g@f)(x);

$\sin(\cos(x))$

Then $P^{-1} A P$ should be a diagonal matrix. Try

> P := matrix(3, 3, [1, 2, 0, -3, 0, 4, -2, 13, 11]);
> evalm(inverse(P)@A@P);

Did you get a diagonal matrix? Alternatively, we can use jordan to diagonalize $A$. Try

> jordan(A, 'P');
> print(P);

This time you should get the same diagonal matrix but the matrix $P$ is different (since it is not unique).

Maple v can also compute eigenvalues and eigenvectors for complex matrices and matrices with floating point entries. Try

> A := matrix(2, 2, [1+10*I, -8*I, 12*I, 1-I*10]);
> eigenvals(A);
> eigenvectors(A);
> B := matrix(2, 2, [1+10*I, -8*I, 12*I, 1-I*10]);
> eigenvals(B);
> eigenvectors(B);
> jordan(B, 'P');
> print(P);

## 7.8 Jordan form

We used the function jordan in the previous section. In general, jordan gives the Jordan canonical form of a square matrix. Try

> C := matrix(4, 4, [-14, 15, 0, 0, 1, -13, 8, 1, -8, -2, -4]);
> jordan(C, 'Q');
> evalm(1/\text{Q}+\text{Q}*\text{Q});

## 7.9 Random matrices

The Maple v function randommatrix(m, n) produces a random integer $m \times n$ matrix with entries between -99 and 99. Try

> with(linalg):
> A := randommatrix(3, 3);
> B := randommatrix(3, 3, unimodular);
> C := randommatrix(3, 3, unimodular);
> F := evalm(transpose(C)@B);
> inverse(F);
7.3 Elementary row operations

MAPLE V can perform all the elementary row and column operations.

<table>
<thead>
<tr>
<th>Elementary row operation</th>
<th>MAPLE V notation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Swap two rows $R_i \leftrightarrow R_j$</td>
<td>swaprow(A, i, j)</td>
</tr>
<tr>
<td>Multiply a row $R_i \rightarrow cR_i$</td>
<td>mulrow(A, i, c)</td>
</tr>
<tr>
<td>Add a multiple of one row to another</td>
<td>addrow(A, i, j, c)</td>
</tr>
</tbody>
</table>

Let

$$A = \begin{bmatrix} 1 & 1 & 3 & -3 \\ 5 & 5 & 13 & -7 \\ 3 & 1 & 7 & -11 \end{bmatrix}$$

Try the following elementary row operations to reduce $A$ to row echelon form.

- with(linalg):
- $A:=\text{matrix}(3,4,[1,1,3,-3,5,5,13,-7,3,1,7,-11])$;
- $A1:=\text{addrow}(A,1,2,-5)$;
- $A2:=\text{addrow}(A1,1,3,-3)$;
- $A3:=\text{mulrow}(A2,2,-1/2)$;
- $A4:=\text{swaprow}(A3,2,3)$;
- $A5:=\text{mulrow}(A4,3,-1/2)$;

The last matrix should be

$$A5 = \begin{bmatrix} 1 & 1 & 3 & -3 \\ 0 & 1 & 1 & 1 \\ 0 & 0 & 1 & -4 \end{bmatrix},$$

which is in row echelon form. In this next section we will see how to check this result using Gaussian elimination.

In MAPLE V the elementary column operations are done in a similar fashion. This time the functions are swapcol, mulcol, and addcol.

7.4 Gaussian elimination

MAPLE V can do Gaussian and Gauss-Jordan elimination. The relevant functions are gausselim and gaussjord. In the previous section we reduced a matrix to echelon form using elementary row operations. Check our result using gausselim and gaussjord.

5.4 Limits

Naturally, there are two forms of the MAPLE V limit function: Limit and limit. These are analogous to Sum and Sum, etc.

The syntax for computing the limit of $f(x)$ as $x \rightarrow a$ is $\text{Limit}(f(x), x=a); \text{value}('n')$. The limit command displays the limit so that it can be checked for types and then the value command computes the limit. To compute the limit

$$\lim_{x \rightarrow 2} \frac{x^2 - 4}{x - 2}$$

we type

- $\text{Limit}((x^2-4)/(x-2), x=2); \text{value}('n');$
- $\text{Limit}((x^2-4)/(x-2), x=2); \text{value}('n');$
- $\text{Limit}((x^2-4)/(x-2), x=2); \text{value}('n');$

Thus, we see that

$$\lim_{x \rightarrow 2} \frac{x^2 - 4}{x - 2} = 4,$$

which can be verified easily with paper and pencil. Alternatively, we could have found the limit in one step by typing $\text{limit}
((x^2-4)/(x-2), x=2)$. Left and right limits can also be calculated as well as limits where $x$ approaches infinity.

Try

- $f:=(x^2-4)/(x^2-6*x+6);$
- $\text{Limit}(f,x=3,\text{right}); \text{value}('n');$
- $\text{Limit}(f,x=\text{infinity}); \text{value}('n');$

5.5 Differentiation

MAPLE V can easily find the derivatives of functions of one or several variables. The syntax for differentiating $f(x)$ is $\text{diff}(f(x), x)$. 

- $f := \sqrt{1-x^2}$
- $\text{diff}(f,x);$
- $\frac{x}{\sqrt{1-x^2}}$
- $g := \text{proc}(x) \rightarrow x^2+exp(x)+\sin(\log(x));$
- $\text{diff}(g(x),x);$
- $2x e^x + x^2 e^x + \frac{\cos(\log(x))}{x}$
The second derivative is given by typing \( \text{diff}(f(x),x,x) \). For the \( n \)-th derivative, use \( \text{diff}(f(x),x^n) \). Use MAPLE V to show that

\[
\frac{d^2 \tan x}{dx^2} = 136 \tan^3 x + 240 \tan^4 x + 120 \tan^6 x + 16.
\]

In MAPLE V, partial derivatives are computed using \text{diff}.

\[
z := \exp(xy) \left(1 + \sqrt{x^2 + 3y^2 - x}\right);
\]

\[
z := e^{xy} \left(1 + \sqrt{x^2 + 3y^2 - x}\right)
\]

\[
> \text{diff}(z,x);
\]

\[
y e^{xy} \left(1 + \sqrt{x^2 + 3y^2 - x}\right) + \frac{e^{xy} (2x - 1)}{2 \sqrt{x^2 + 3y^2 - x}}
\]

\[
> \text{normal}(\text{diff}(z,x,y) - \text{diff}(z,y,x));
\]

0

The syntax for \( \frac{\partial z}{\partial x} \) is \( \text{diff}(z,x,x) \) and for \( \frac{\partial^2 z}{\partial y \partial x} \) is \( \text{diff}(z,x,y) \). For

\[
z := e^{xy} \left(1 + \sqrt{x^2 + 3y^2 - x}\right)
\]

we found that

\[
\frac{\partial z}{\partial x} = e^{xy} \left(1 + \sqrt{x^2 + 3y^2 - x}\right)
\]

\[
+ \frac{e^{xy} (2x - 1)}{2 \sqrt{x^2 + 3y^2 - x}}
\]

and

\[
\frac{\partial^2 z}{\partial y \partial x} = \frac{\partial^2 z}{\partial x \partial y}.
\]

MAPLE V also has the differential operator \( D \). If \( f \) is a differentiable function of one variable, then \( Df \) is the derivative \( f' \). We calculate \( g'(x) \) for our function \( g \) above.

\[
g := z \rightarrow z^2 \exp(x) + \sin(x);
\]

\[
g := z \rightarrow z^2 e^x + \sin(z)
\]

\[
> \text{D}(g);
\]

\[
z \rightarrow 2xe^x + z^2e^x + \cos(z)
\]

\[
28
\]

The matrix operations, inverse, transpose, and trace.

<table>
<thead>
<tr>
<th>Matrix operation</th>
<th>Mathematical notation</th>
<th>MAPLE V notation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Addition</td>
<td>( A + B )</td>
<td>( A + B )</td>
</tr>
<tr>
<td>Subtraction</td>
<td>( A - B )</td>
<td>( A - B )</td>
</tr>
<tr>
<td>Scalar multiplication</td>
<td>( c \cdot A )</td>
<td>( c \cdot A )</td>
</tr>
<tr>
<td>Matrix multiplication</td>
<td>( A \cdot B )</td>
<td>( A \cdot B )</td>
</tr>
<tr>
<td>Matrix power</td>
<td>( A^n )</td>
<td>( A^n ) or ( \text{multiply}(A,B) )</td>
</tr>
<tr>
<td>Inverse</td>
<td>( A^{-1} )</td>
<td>( \text{inverse}(A) )</td>
</tr>
<tr>
<td>Transpose</td>
<td>( A^T )</td>
<td>( \text{transpose}(A) )</td>
</tr>
<tr>
<td>Trace</td>
<td>( \text{tr}(A) )</td>
<td>( \text{trace}(A) )</td>
</tr>
</tbody>
</table>

Look at the following example:

\[
> \text{with(linalg)};
\]

\[
> A := \text{matrix}(2,2,[1,2,3,4]);
\]

\[
> B := \text{matrix}(2,2,[-2,3,-5,1]);
\]

\[
> A+B;
\]

\[
[ -1 \quad 5 ]
\]

\[
[ -2 \quad 5 ]
\]

Notice that we had to use the function \( \text{evalm} \) to display the matrix \( A + B \). Now try the following:

\[
> \text{with(linalg)};
\]

\[
> A := \text{matrix}(2,3,[1,2,3,4,5,6]);
\]

\[
> B := \text{matrix}(2,4,[-2,4,7,-3,5,1]);
\]

\[
> C := \text{matrix}(2,2,[1,-2,3,4]);
\]

\[
> A+B;
\]

\[
> \text{evalm}('*');
\]

\[
\begin{bmatrix}
-1 & 5 \\
-2 & 5
\end{bmatrix}
\]

Now check your results with pencil and paper. You should have found that

\[
A - 2C = \begin{bmatrix}
1 & 17 \\
9 & 29
\end{bmatrix}
\]

53
We may examine the behaviour of this function as \( t \) changes using `animate`. Try,

\[
> \text{with(plots);}
\]

\[
> \text{animate(1/(1+x*t),x=0..10,t=0..1,}
\]

\[
\text{frames=10);}
\]

A plot of \( f_0(x) = 1 \) should appear in the worksheet. Now click on the plot. A new context bar should appear containing a window for coordinates and nine new buttons similar to those on a cassette tape player. Try clicking on each button to see its effect.

- Stop the animation.
- Play the animation.
- Move to the next frame.
- Set the animation direction to be backward.
- Set the animation direction to be forward.
- Decrease the speed of the animation.
- Increase the speed of the animation.
- Set animation to run in single-cycle mode.
- Set animation to run in continuous-cycle mode.

Now click on \( \square \) to play the animation. The `frames` option allows you to set the number of separate frames in the animation. To view each frame, click on \( \square \). Try setting `frames=50.

Now try

\[
> \text{animate([Pi/2*sin(t*(u+1)),sin(2*t)}
\]

\[
*sin(Pi/2*sin(t+u+t)),t=-2*Pi..2*Pi],}
\]

\[
w=0..1,frames=20,numspoints=200,}
\]

\[
\text{color=blue);}
\]

The 3-dimensional animation command is `animate3d`. The surface

\[
x^2 - y^2 = z,
\]

may be parametrized by

\[
x = r \cos t, \quad y = r \sin t, \quad z = r^2 \cos 2t.
\]

Try animating a rotation of this surface

\[
> \text{Int(x^4/2/sqrt(1-x^3),x);}
\]

\[
\int \frac{x^3}{\sqrt{1-x^3}} \, dx
\]

\[
> \text{value(\%)};
\]

\[
-2/3 \sqrt{1-x^3}
\]

\[
> \text{Int(1/x/sqrt(x^2-1),x=1..2/sqrt(3));}
\]

\[
\int_{1}^{2/\sqrt{3}} \frac{1}{x \sqrt{x^2-1}} \, dx
\]

\[
> \text{value(\%)};
\]

\[
1/6
\]

\[\text{MAPLE} \text{ v} \text{ easily found that}
\]

\[
\int \frac{x^2}{\sqrt{1-x^3}} \, dx = -\frac{2}{3} \sqrt{1-x^3}
\] and

\[
\int_{1}^{2/\sqrt{3}} \frac{1}{x \sqrt{x^2-1}} \, dx = \frac{\pi}{6}.
\]

\[\text{MAPLE v} \text{ can do improper integrals and multiple integrals in the obvious way. Try finding}
\]

\[
\int_{0}^{\infty} re^{-r^2} \, dr
\]

by typing `int(r*exp(-r^2),r=0..infinity)`. Try evaluating the double integral

\[
\int \int y \sin(2x+3y^2) \, dx \, dy
\]

by first integrating

\[\text{with respect to } x \text{ and then with respect to } y.
\]

If `MAPLE v` does not know the value of a definite integral, try `evalf`.

\[
> \text{Int(sqrt(1+x^4),x=0..1);}
\]

\[
\int_{0}^{1} \sqrt{1+x^4} \, dx
\]

\[
> \text{value(\%)};
\]

\[
\int_{0}^{1} \sqrt{1+x^4} \, dx
\]

\[
> \text{evalf(\%)};
\]

\[1.00488379
\]

\[31\]
Although Maple V was unable to evaluate the integral, it was able to find the approximation

$$\int_0^1 \sqrt{1 + x^6} dx \approx 1.064088379.$$

5.7.1 Techniques of integration

Maple V knows some standard techniques of integration. These are in the student package and are loaded with the command with(student).

5.7.1.1 Substitution

In Maple V, to do integration by substitution, we use the changevar command. The syntax is changevar(f(u)-h(x), integral, u) where integral is an integral in the variable x, f(u) = h(x) is the substitution, and u is the new variable in the integral.

> with(student);
> Int(x^4/sqrt(1-x^10),x);

$$\int \frac{x^4}{\sqrt{1-x^{10}}} dx$$

> G := value('G');

$$G := \int \frac{x^4}{\sqrt{1-x^{10}}} dx$$

> G2:=changevar(u=x^5,G,u);

$$1/5 \arcsin(u)$$

> sub(u=x^5,G2);

$$1/5 \arcsin(x^5)$$

> diff('u',x);

$$\frac{x^4}{\sqrt{1-x^{10}}}$$

Although Maple V was unable to evaluate the integral at first, we were able to help it along by using changevar and the substitution u = x^5. Maple V was then able to evaluate the new integral. We substituted u = x^5 to obtain

$$\int \frac{x^4}{\sqrt{1-x^{10}}} dx = \sin^{-1}(x^5).$$

We then checked our answer using diff. Try evaluating the integral

$$\int \frac{x^7}{\sqrt{1-x^{10}}} dx$$

5.7.2 Implicit surfaces

> with plots;
> implicitplot3d(y^2 - x^2 - z, x=-2..2, y=-2..2, z=-4..4);

The resulting plot is given in Figure 5.10.

In Section 5.2.1 we obtained a plot of the surface

$$x^2 + y^2 - z^2 = 1,$$

by using a parametrization. This time, try

> implicitplot3d(x^2 + y^2 - z^2 = 1, x=-1..1, y=-1..1, z=-1..1);
> implicitplot3d(x^2 + y^2 - z^2 = 1, x=-2..2, y=-2..2, z=-1..1);

Notice how care must be taken in choosing the range for each variable.

6.2.6 Title and text in a plot

A title or text may be inserted in a 3-dimensional plot in the same way it was done in Section 6.1.7 for 2-dimensional plots. Try

> with plots;
> p1:=plot3d(exp(-x^2+y^2+2-1),x=-2..2,y=-2..2, font=[TIMES,ROMAN,12],titlefont = [HELVETICA,BOLD,10], title="The surface z=exp(-x^2+y^2-1)^2");
> p2:=textplot3d([0.1,0.1,0."Circular

Rim"], align=RIGHT, color=BLUE);
> display(p1,p2);

6.2.7 3-dimensional plotting options

The options axes, font, labels, labelfont, linestyle, numpoints, scaling, symbol, thickness, title, titlefont, and view should work like they did for 2-dimensional plotting (see Section 5.1.8). Other options are ambientlight, color, contours, coords, gridstyle, light, lightsmodel, orientation, projection, shading, and style. See ?plot3d[options] for more information.

6.3 Animation

Maple V is capable of animating 2- and 3-dimensional plots. The two animation functions are animate and animate3d. These are in the plots package. For fixed t we consider the function

$$f(t) = \frac{1}{1 + xt^2}$$
6.2.1 Parametric plots
To plot the surface parametrized by
\[ x = f(u, v), \quad y = g(u, v), \quad z = h(u, v), \]
where \( a \leq u \leq b, \ c \leq v \leq d; \) use the command \texttt{plot3d([f(u, v), g(u, v), h(u, v)], \ u=a..b, \ v=c..d).} For example, the hyperboloid
\[ x^2 + y^2 - z^2 = 1, \]
may be parametrized by
\[ x = \sqrt{1 + u^2 \cos(t)}, \quad y = \sqrt{1 + u^2 \sin(t)}, \quad z = u, \]
where \(-\infty < u < \infty\) and \(0 \leq t \leq 2\pi.\) Try
\[
\text{plot3d}([\text{sqrt}(1+u^2)\cdot\cos(t), \text{sqrt}(1+u^2)\cdot\sin(t), u=-1..1, \ t=0..2\cdot\pi]);
\]
A plot with \((0, 0)\) is given in Figure 6.8.

![Figure 6.8 Maple plot of a hyperboloid](image)

6.2.2 Multiple plots
To plot the two functions
\[
z = e^{-x^2-y^2}, \quad z = x + y + 1, \]
is
\[
y = \frac{1}{2}\cos(x)e^{-3x} - \frac{1}{2}\sin(x)e^{-3x} + c_1e^{-3x} + c_2e^{-2x},
\]
where \(c_1\) and \(c_2\) are any constants.

Systems of differential equations can be solved in an analogous fashion. To solve the initial value problem
\[
y' + x' = e^x, \quad y(0) = 8/9, \quad y' - 3z = x, \quad z(0) = 10/9, \]
try
\[
\text{dsolve}([\text{ode}, \text{ode}, t(0)=8/9, g(0)=10/9], [y, z]);
\]
To find series solutions, use the option \texttt{type=series}. Type \texttt{dsolve} to get more information and examples.

5.10 Asymptotic expansions
To find the first \(n\) terms of the asymptotic expansion of the function \(f(z)\) we use the command \texttt{asympt(f(z), z, n).} For example, below we find the first few terms of the asymptotic expansion of the psi-function (which is the logarithmic derivative of the gamma function).

\[
\text{asympt}(\text{Psi}(z), z, 3);
\]
\[
\ln(z) = \frac{1}{2z} - \frac{1}{12z^2} + O \left( \frac{1}{z^3} \right)
\]

6. Graphics
\texttt{Maple V} can plot functions of one variable, phase curves, functions of two variables, and surfaces in three dimensions. It can also handle parametric plots and animations. The two main plotting functions are \texttt{plot} and \texttt{plot3d}.
6.1 2-dimensional plotting

The syntax for plotting an expression (or function) in x is \texttt{plot(f(x), x=a..b)}. For example, to plot \( \sin(x) \) for \(-2\pi \leq x \leq 2\pi\), we type

\begin{verbatim}
> plot(sin(x), x=-2*Pi..2*Pi);
\end{verbatim}

The resulting plot appears in Figure 6.1.

Observe that in Maple V (Release 4) the plot actually appears in the current document. Now try clicking on the plot. A rectangular box, containing the plot, should appear. There should also be little black squares in the corners. Try holding the left mouse button down to resize the plot. Notice also that the menu bar and the context bar have changed. The Insert, Format and Options menus have been replaced by the Style, Axes, Projection, and Animation menus. The context bar has changed completely. There should be a small window containing a pair of coordinates and nine new buttons. Try clicking on each button to see its effect.

Displays the coordinates of the point under the tracker (i.e., the point clicked).

- \( [0.5191, 0.4893] \)

Now, try clicking \( \text{R} \) to see some hidden detail of the plot. You might use the grid option to increase the number of contours plotted. Try

\begin{verbatim}
> plot3d(exp(-x^2 + y^2), x=-2..2,
>        y=-2..2, grid=[60,60]);
\end{verbatim}

Figure 6.1 Maple plot of \( y = \sin x \).

Figure 6.7 A Maple plot with boxed axes.

- Render the plot using the hidden line removal style.
- Render the plot using the contour style.
- Render the plot using the wireframe style.
- Render the plot using the point style.
- Draw the plot axes as an enclosed box.
- Draw the plot axes as an exterior frame.
- Suppress the drawing of plot axes.
- Use the same scale on each axis.
- \( \text{R} \) Redraw the plot.

Now, hold the first mouse button down on the plot. A cube should appear. Drag the mouse so that the cube rotates to the desired position. Notice that the value of \((\theta, \phi)\) has changed. Double click on the cube or click on \( \text{R} \) to redraw the plot. Below is a plot obtained by clicking on \( \text{R} \) and \( \text{R} \) and selecting \((\theta, \phi) = (22, 67)\).
6.1.7 Title and text in a plot

To put a title above a plot, we use the option title. Try

\[
> \text{p1:=plot([sqrt(x),3*log(x)],x=0..400,}\n\quad \text{title='The Square Root and}\n\quad \text{log functions');}\n\]
\[
> \text{display(p1);}\n\]

To add text to a plot, we use the textplot and display functions in the plots package. Try

\[
> \text{p2:=textplot([[360,16,'y=sqrt(x)'],}\n\quad \text{[130,10,'y=3log(x)']],}\n\quad \text{title='The Square Root and}\n\quad \text{log functions');}\n\]
\[
> \text{display(p1,p2);}\n\]

\[
\text{textplot([x1,y1,string]) creates a plot with string positioned at } [x1,y1].\n\]

Figure 6.5 Maple plot of some data points.

6.1.3 Multiple plots

To plot the two functions

\[
y = \sqrt{x}, \quad y = 3 \log(x),\n\]

try

\[
> \text{plot([sqrt(x),3*log(x)],x=0..400);}\n\]

The resulting plot is given in Figure 6.3. Each curve is plotted with a different color. Observe that our plot does not seem to illustrate the expected behaviour of the log function near \(x = 0\). To get a more accurate plot, we can use the numpoints option. Try

\[
> \text{plot([sqrt(x),3*log(x)],x=0..400,}\n\quad \text{numpoints=1000);}\n\]

An alternative method for doing multiple plots is to use the display function in the plots package. Try

\[
> \text{with(plots);}\n\]
\[
> \text{p1:=plot(sqrt(x),x=0..0.400);}\n\]
\[
> \text{p2:=plot(3*log(x),x=0..0.400);}\n\]
\[
> \text{display(p1,p2);}\n\]

When defining \(p1\) and \(p2\), use a colon unless you want to see all the points maple uses to plot the functions. To see all the functions in the plots package, type

\[
> \text{with(plots);}\n\]

Figure 6.3 Maple plot of \( y = \sqrt{x} \) and \( y = 3 \log x \).
6.1.4  Polar plots

To plot polar curves we use the `polarplot` function in the `plots` package. Use the command `polarplot(f(t), t=a..b)` to plot the polar curve \( r = f(\theta) \). Try

```maple
> with(plots):
polarplot(cos(5*t), t=0..2*Pi);
```

![Figure 6.4 Maple plot of the polar curve \( r = \cos 0 \).

When you try this the first time you will notice the scale on the \( x \)-axis is different to that on the \( y \)-axis. To make the scales the same, hold the first mouse button on Projection and release on Constrained; or, better still, click on [B].

6.1.5  Plotting implicit functions

In Section 6.1.2 we used a parameterization to plot the curve \( x^2 + 4y^2 = 1 \). Alternatively, we can plot implicitly defined functions using the `implicitplot` command in the `plots` package. Try

```maple
> with(plots):
> implicitplot(x^2+4*y^2-1, x=-1..1,
y=-1/2..1/2);
```

This should agree with what we obtained before.

6.1.6  Plotting points

In Maple, we plot the points

\[[x_1,y_1], [x_2,y_2], \ldots, [x_n,y_n]\]

with the command `plot([[x1,y1], [x2,y2], \ldots, [xn,yn]])`. Try

```maple
> L := [[0, 0], [1, 1], [2, 3], [3, 2], [4, -2]]:
> plot(L);
```

The resulting plot is given in Figure 6.5. Notice that Maple \( \text{v} \) (by default) has drawn lines between the points. To plot the points and nothing but the points, try

```maple
> plot(L, style=point);
```
The points correspond to plus-signs.
See plot[options] for a complete listing. Options include

- **axes**: frame, boxed, normal, or none
- **discont**: for plotting a discontinuous function
- **font**: font=HELVETICA, 12
- **labelfont**: font for labels on axes
- **linestyle**: dashed pattern for lines
- **numpoints**: number of plotting points
- **resolution**: horizontal display resolution
- **scaling**: Use constrained for equal scale.
- **style**: Use point for points.
- **symbol**: symbol for point style
- **thickness**: line thickness
- **title**: title for the plot
- **titlefont**: font for the title
- **xtickmarks**: number of x-axis scale marks

### 6.1.9 Saving and printing a plot

There are several ways to save a plot. Any plot that is part of a worksheet will be saved when the worksheet is saved. See Sections 9.2 and 9.3. The plotsetup function can be used to save a plot as a file suitable for other drivers. This is done by specifying the plotdevice variable. Common settings for plotdevice are

- **ps**: encapsulated Postscript file
- **jpeg**: 24-bit color JPEG file
- **hpgl**: HP GL file

Here is an example.

```
> plotsetup(ps, plotoutput='plot.ps',
          plotoptions='portrait, noborder');
> plot(sin(x), x=0..2*Pi);
> interface(plotdevice=inline);
```

In this session, a plot of \( y = \sin(x) \) was written to the Postscript file \( plot.ps \), in portrait style with no surrounding border. The interface function was used so that any future plot will be within the worksheet. Otherwise, if plotsetup is not changed, any future plot will overwrite the file \( plot.ps \).

A plot may be printed as part of the worksheet using the menu. Alternatively, it can be saved as a file and printed using a graphics driver. For example, try

```
> plotsetup(hpgl, plotoutput='plot.hp',
           plotoptions='laserjet');
```
when printing a plot with a HP Laserjet printer. For more information, use the help commands ?plotsetup, ?plot[device].

6.2 3-dimensional plotting

The syntax for plotting an expression (or function) in two variables (say \( x, y \)) is

\[
\text{plot3d}(f(x,y), x=a..b, y=c..d).
\]

For example, to plot the function \( z = e^{-(x^2+y^2-1)^2} \) for \(-2 \leq x, y \leq 2\), we use the command

\[
> \text{plot3d}(\exp(-(x^2 + y^2 -1)^2), x=-2..2, y=-2..2);
\]

![Image](image.jpg)

Figure 6.6 A plot of the function \( z = e^{-(x^2+y^2)|x|^2} \).

Observe (as before with 2-dimensional plotting) that the plot appears in the worksheet. Now try clicking on the plot. Notice the appearance of the Style, Colour, Axes, Projection, and Animation menus. The context bar has also changed. There should be a pair of small windows labelled \( \theta \) and \( \phi \), each containing the number 45. This pair of numbers refer to a point in spherical coordinates and correspond to the orientation of the plot. There should also be thirteen new buttons. Try clicking on each button to see its effect.

\[ 51 \quad \theta \quad 50 \quad \phi \]

Specifies orientation.

- \[ \square \]
  - Reader the plot using the polygon patch style with gridlines.
- \[ \square \]
  - Reader the plot using the polygon patch style.
- \[ \square \]
  - Reader the plot using the polygon patch and contour style.

6.1.1 Restricting domain and range

Try the plot command \( \text{plot}(\sec(x), x=-\Pi..2*\Pi) \). Notice the “spikes” at \( x = -\pi/2, \pi/2 \) and \( 3\pi/2 \) in your maple plot. These correspond to singularities of \( \sec(x) \). We restrict the range to get a more reasonable plot.

\[
> \text{plot}(\sec(x), x=-\Pi..2*\Pi, y=-5..5);
\]

The resulting plot appears in Figure 6.2.

So, to plot \( y = f(x) \), where \( a \leq x \leq b \), and \( c \leq y \leq d \), in MAPLE we use the command \( \text{plot}(f(x), x=a..b, y=c..d) \).

6.1.2 Parametric plots

To plot the curve parametrized by

\[ x = f(t), \quad y = g(t), \quad \text{for } a \leq t \leq b, \]

we use the command \( \text{plot}([f(t), g(t), t=a..b]) \). The ellipse

\[ x^2 + 4y^2 = 1, \]

can be parametrized as

\[ x = \cos(t), \quad y = \frac{1}{2}\sin(t), \quad \text{where } 0 \leq t \leq 2\pi. \]

Try

\[
> \text{plot}([\cos(t), 1/2*\sin(t), t=0..2*\Pi])
\]

This should give you the desired plot.
5.8 Taylor and series expansions

The command to find the first n terms of the Taylor series expansion for \( f(x) \) about the point \( x = c \) is `taylor(f(x) . x=c, n)` . We compute the first five terms of the Taylor series expansion of \( y = (1 - x)^{-1/2} \) about \( x = 0 \).

```maple
> y := 1/sqrt(1-x);
> taylor(y, x=0, 5);
1 + 1/2 x + 3/8 x^2 + 5/16 x^3 + 35/128 x^4 + O(x^5)
```

To find a specific coefficient in a Taylor series expansion, use `coeff` .

```maple
> J := product(1-x^n, n=1..150);
> taylor(J, x=0, 20);
1 - 3x + 5x^2 - 7x^3 + 9x^4 - 11x^5 + O(x^6)
> coeff(J, x, 15); # -11
```

To convert a series into a polynomial, try `convert(series, polynomial)` . Also, see `series` .

5.9 Solving differential equations

To solve the differential equation \( dy/dx \) involving \( y = f(x) \) we use the command `dsolve(dy/dx)` .

```maple
> f := 'f'; # y := f(x);
y := f(x)
> dy := diff(y, x);
\( \frac{dy}{dx} = f(x) \)
> ddy := diff('y', x);
\( \frac{d^2 y}{dx^2} = f(x) \)
> dsolve(ddy=S*dy+dy*dy = sin(x)*exp(-3*x), y);
1/2 \cos(x) e^{-3x} - 1/2 \sin(x) e^{-3x} + c_1 e^{-3x} + c_2 e^{-2x}
```

We found that the general solution to the differential equation
\[
y'' + y' + 6y = \sin(x) e^{-3x}
\]

try
```maple
> plot3d([exp(-x^2-y^2), x+y+1], x=-2..2, y=-1..1);
```

with \((\theta, \phi) = (120, 45)\). As with 2-dimensional plotting, multiple 3-dimensional plots can be produced using the `display` function in the `plots` package. Try
```maple
> with(plots):
> p1:=plot3d(exp(-x^2-y^2), x=-2..2, y=-1..1);
> p2:=plot3d(x+y+1, x=-2..2, y=-1..1);
> display(p1,p2);
```

6.2.3 Space curves

To plot the space curve
\[
x = f(t), \quad y = g(t), \quad z = h(t),
\]
where \( a \leq t \leq b \), we use the `spacecurve` function in the `plots` package. The command is `spacecurve([f(t), g(t), h(t)], t=a..b)` . We plot the helix
\[
x = \cos t, \quad y = \sin t, \quad z = t.
\]
Try
```maple
> with(plots):
> spacecurve([cos(t), sin(t), t], t=0..4*Pi, numpoints=200);
```

Figure 6.9 Maple plot of a helix.
6.2.4 Contour plots

The graph of a function of two variables may be visualized with a 2-dimensional contour plot. To produce contour plots, we use the functions contourplot and contourplot3d in the plots package. Contourplot3d "paints" the contour plot on the corresponding surface. Try

\[
\begin{align*}
\text{with}(\text{plots}); \\
\text{contourplot}(\text{exp}(-(x^2+y^2-2)^2), \\
x=-1.3..1.3, y=-1.3..1.3, \\
\text{filled}=\text{true}, \text{coloring}=[\text{blue}, \text{red}]); \\
\text{contourplot3d}(\text{exp}(-(x^2+2y^2-1)^2), \\
x=-1.3..1.3, y=-1.3..1.3, \\
\text{filled}=\text{true}, \text{coloring}=[\text{blue}, \text{red}]);
\end{align*}
\]

![Figure 6.10 Maple plot of a hyperbolic paraboloid.](image)

6.2.5 Plotting surfaces defined implicitly

To plot the surface defined implicitly by the equation

\[ f(x, y, z) = c, \]

use the command implicitplot3d \( f(x, y, z) = c, x=a..b, y=d..e, z=g..h \) in the plots package. For example, to plot the hyperbolic paraboloid

\[ y^2 - x^2 = z, \]

\text{try}

\[ \text{implicitplot3d}(y^2 - x^2 = z, x=-1..1, y=-1..1, z=-1..1, \text{grid}=[100, 100, 100]); \]

using the substitution \( u = x^2 \).

5.7.1.2 Integration by parts

To do integration by parts, we use the command intparts. The syntax is

\[ \text{intparts}(\text{integral}, \text{x}) \]

where \( x \) is the variable of integration in the \( \text{integral} \).

\[ \int x \cos(3x) \, dx \]

\[ \text{intparts}(\text{"}, \text{x}); \]

\[ 1/3 \sin(3x) - \int 1/3 \sin(3x) \, dx \]

\[ \text{value}(\text{"}); \]

\[ 1/3 \sin(3x) + 1/9 \cos(3x) \]

Thus MAPLE V has helped us by providing the working to evaluate the integral by parts:

\[ \int x \cos(3x) \, dx = 1/3 \sin(3x) - \int 1/3 \sin(3x) \, dx \]

\[ = 1/3 \sin(3x) + 1/9 \cos(3x). \]

5.7.1.3 Partial fractions

The command for finding the partial fraction decomposition of a rational function \( \text{rational} \) in the variable \( x \) is \text{convert} \( (\text{rational}, \text{parfrac}, x) \). As an example, we use MAPLE V to find the integral

\[ \int \frac{4x^4 + 9x^3 + 12x^2 + 9x + 4}{(x + 1)(x^2 + x + 1)^2} \, dx. \]

\[ \text{rat} := (4x^4+9x^3+12x^2+9x+4)/(x+1)/(x^2+x+1)^2; \]

\[ \text{convert} \left( \text{rat}, \text{parfrac}, x \right); \]

\[ \frac{2}{x+1} + \frac{1 + 2x}{x^2 + x + 1} + \frac{1}{(x^2 + x + 1)^2} \]

\[ \text{int}(\text{"}, x); \]

\[ 2 \ln(x + 1) + \ln(x^2 + x + 1) + \frac{1}{3} \frac{2x + 1}{x^2 + x + 1} \]

\[ + \frac{4}{5} \sqrt{3} \arctan \left( \frac{1}{5} \frac{2x + 1}{\sqrt{3}} \right) \]
The second method involves using the mirc library function `extrema`, so we must first load the desired function with `readlib(extrema)`. The function `extrema` is able to find the minimum and maximum values of algebraic functions of one or several variables, subject to 0 or more constraints. It returns a set of possible minimum and maximum values with the option of returning a set of points where these values occur. The syntax for the function is `extrema(f, [g1, g2, ..., gn], [x1, x2, ..., xn], 's')`. Here, $f$ is the function. The constraints are $g_i = 0, g_2 = 0, ..., g_n = 0, x_1, x_2, ..., x_n$ are the variables and $s$ is the unevaluated variable for holding the set of possible points where the extrema occur.

```maple
> readlib(extrema):
> f := 2*x^2 + y + y^2;
f := 2*x^2 + y + y^2
> g := x^2 + y^2 - 1;
g := x^2 + y^2 - 1
> extrema(f, [g], [x, y], 's');
{0, 9/4}
> s;
{[x = 0, y = 1], [x = 0, y = -1]},
{[y = 1/2, x = 1/2*RootOf(_Z^2 - 3)]}
> simplify(subs(s[1], f));
0
> simplify(subs(s[2], f));
2
> simplify(subs(s[3], f));
9/4
```

By using the command `extrema(f, [g], [x, y], 's')`, we found that the extreme values of $f(x, y) = 2x^2 + y + y^2$ subject to the constraint $x^2 + y^2 = 1$ are 0 and 9/4. The set of possible points where the extrema occurred was assigned to the variable $s$. Using `simplify` and `subs`, we substituted each set of points into $f$. In this way, we found that the minimum value 0 occurs at $x = 0, y = -1$ and the maximum value $9/4$ occurs at $x = \pm \sqrt{3/2}, y = 1/2$.

### 5.7 Integration

If $f$ is an expression involving $x$, then the syntax for finding the integral $\int_{a}^{b} f(x) \, dx$ is `int(f, x=a..b)`. For the indefinite integral we use `int(f, x)`. There are also the unevaluated forms `Int(f, x=a..b)` and `Int(f, x)`.

> with plots;
> animate3d([r*cos(t+a), r*sin(t+a), r^2
* cos(2*t)], r=0..1, t=0..2*Pi, a=0..3,
frames=10, style=patch, title='The
Rotating Saddle');
A little adjusting creates a Flying Pizza
> animate3d([r*cos(t+a), r*sin(t+a), r^2
* cos(2*t)*sin(a)], r=0..1, t=0..2*Pi,
a=0..2*Pi, frames=10, style=patch,
title='The Flying Pizza');
Try clicking on $\textcircled{C}$ to set your pizza in continuous motion.

### 7. Linear Algebra

Maple v can do symbolic and floating-point matrix computations. The linear algebra functions are contained in the `linalg` package. Try

> ?linalg

to see a list of these functions.

#### 7.1 Vectors, arrays, and matrices

Matrices and vectors are data types defined within the `linalg` package. It is necessary to load the `linalg` package before creating matrices and vectors. In Maple v a matrix is a two-dimensional array. It would be a good idea to reread Section 4.5 on arrays. We give some examples on creating vectors and matrices.

> with(linalg):
> v:=vector([1, 2, 3]);
v := [1, 2, 3]
> A:=matrix(2, 3, [a, b, c, d, e, f]);
$$
\begin{bmatrix}
a & b & c \\
d & e & f \\
\end{bmatrix}
$$
> v;
v
> A;
A
> print(v);
[1, 2, 3]
> print(A);

\[
\begin{bmatrix}
  a & b & c \\
  d & e & f \\
\end{bmatrix}
\]

We used the vector and matrix functions in the linalg package to define the 3-dimensional vector v and the \(2 \times 3\) matrix A. Notice that typing v or A did not cause the vector or matrix to be displayed. We displayed them using the print command. Also, try

> op(A);
> eval(A);

It is possible to enter a matrix interactively using the entermatrix command.

> with(linalg):
> B := matrix(2,2);

\[
B := \begin{array}{cc}
  12 & 13 \\
  14 & 15 \\
\end{array}
\]

Note that the semi-colon must still be used when entering matrix elements.

A fun way to create matrices is to use a function \(f(x,y)\) of two variables. The function \(\text{matrix}(m,n,f)\) produces the \(m \times n\) matrix whose \((i,j)\)-th entry is \(f(i,j)\). Try

> f := (i,j) -> x^i*y^j;
> A := matrix(4,4,f);
> factor(det(A));

5.6 Extrema

MAPLE is able to find the minimum and maximum values of certain functions of one or several variables with zero or more constraints. There are three possible approaches: (1) using the built-in functions \text{maximize} and \text{minimize}, (2) using the miscellaneous library function \text{extrema}, and (3) using the \text{simplex} package (for linear functions). We will describe (1) and (2). See \text{simplex} for (3).

The functions \text{maximize} and \text{minimize} can find the maximum and minimum values of a function of one or several variables. There is also an option for restricting some of the variables to certain intervals. It is advised that this facility be used with care and only with algebraic functions - not the transcendental functions such as \(\exp, \sin, \cos\), etc.

We can find the maximum value of the function \(f(x)\) by typing \text{maximize}(f(x)). The command \(\text{maximize}(f(x), [x, [a..b]])\) gives the maximum of the function with \(x\) restricted to the interval \([a,b]\).

> maximize(sin(x)+cos(x));
\[
\sqrt{2}
\]
> maximize(x^2-5*x+1, [x, [x=0..3]]);
1
> maximize(sin(x), [x, [x=0..1]]);
1

We found that the maximum value of \(\sin x + \cos x\) is \(\sqrt{2}\). For \(0 \leq x \leq 3\), the maximum value of \(x^2 - 5x + 1\) was found to be 1. However, MAPLE incorrectly computed the maximum of \(\sin x\) (for \(0 \leq x \leq 1\)) to be 1. The function \(\sin x\) is increasing on \([0,1]\) so the actual maximum value is \(\sin 1 \approx 0.841\). We hope this bug will be fixed.

To find the minimum value of a function, use the command \text{minimize} whose syntax is analogous to that of \text{maximize}. MAPLE can also handle functions of more than one variable.

> minimize(x^2+y^2, [x,y]);
0
> minimize(x^2+y^2, x);
\[
y^2
\]

We found the minimum value of \(x^2 + y^2\) to be 0. The function \(\text{minimize}(x^2 + y^2, x)\) found the minimum value of the function \(x^2 + y^2\), considered as a function of \(x\) with \(y\) fixed.

7.2 Matrix operations

MAPLE can do the usual matrix operations of addition, multiplication, scalar multi-
> factor(n);
1/6 n (n + 1) (2n + 1)

Notice that Maple V knows certain summation formulas such as
\[ \sum_{i=1}^{n} i^2 = \frac{1}{6} n (n + 1) (2n + 1). \]

In Maple V, the syntax for the product
\[ \prod_{i=1}^{n} f(i) = f(1) \cdot f(2) \cdots f(n) \]
is Product(f(i), i=1..n).
> f := 'f'; q := 'q';
> Product(f(i), i=1..n);
> Product(1-q^i, i=1..5);
> value(n);
(1 - q)(1 - q^2)(1 - q^3)(1 - q^4)(1 - q^5)
> expand(n);
-3 q^{15} + q^{14} + q^{13} - q^{10} - q^9 - q^8 + q^7 + q^6 + q^5 - q^2 - q + 1

As with sum and Sum, for product, the product is evaluated, but with Product, it is not. Note that we could've evaluated the product \( \prod_{i=1}^{n} 1 - q^i \) using Product(1-q^i, i=1..5).

A common problem with Sum and Product is the following:
> i:=2;
> sum(i^3, i=1..5);
Error, (in sum) summation variable previously assigned, second argument evaluates to
> 2
The problem occurred in sum since i had already been assigned the value 2. There are two ways around this problem. One way is to restore the variable status of i by typing i := 'i'. The second way is to replace i by 'i' in the sum.
> sum('i'^3, 'i'=1..5);
> with(linalg):
> A:=matrix([3., 1., 1., -3., 5., 5., 13., -7., 3., 1., -11.]);
> gausselim(A);
> gaussjord(A):

7.5 Inverses and determinants
To find the inverse of a matrix and its determinant, we use the functions inverse and det.
> with(linalg):
> A:=matrix([3, 3, 1, 1, 3, 5, 5, 13, 3, 1, 7]);
> det(A);
-1
> B:=inverse(A);
\[
B := \begin{bmatrix}
\frac{1}{2} & 1 & \frac{1}{2} \\
-1 & \frac{1}{2} & \frac{1}{2} \\
\frac{1}{2} & \frac{1}{2} & 0
\end{bmatrix}
\]

We first found that \( \det(A) = -1 \neq 0 \) so that \( A \) is invertible; then found that
\[ A^{-1} = \begin{bmatrix}
\frac{1}{2} & 1 & \frac{1}{2} \\
-1 & \frac{1}{2} & \frac{1}{2} \\
\frac{1}{2} & \frac{1}{2} & 0
\end{bmatrix}. \]

Now check your answer:
> evalm(B*A);

7.6 Row space, column space, nullspace
Let
\[ A = \begin{bmatrix}
1 & 4 & -10 & 3 & -3 \\
10 & 41 & -102 & 30 & -31 \\
-9 & -19 & 56 & -27 & 10
\end{bmatrix}. \]

We can use Maple V to find the rank of \( A \) and to find bases for the row space, column space, and null space. The relevant Maple V functions are rank, rowspace, colspace, and nullspace.
> with(linalg):
> A:=matrix([3, 5, 1, 4, -10, 3, -3, 10, 41, -102, 19, -102, 1]);
30, -31, -9, -19, 56, -27, 10]:
> rank(A):
2
> rowspace(A):
\{[1, 0, -2, 3, 1], [0, 1, -2, 0, -1]\}
> colspace(A):
\{[1, 0, -179], [0, 1, 17]\}
> nullspace(A):
\{[-1, 1, 0, 0, 1, -3, 0, 0, 1, 0, 2, 2, 1, 0, 0]\}

7.7 Eigenvalues and diagonalization

Let
\[ A = \begin{bmatrix} 177 & 77 & -28 \\ -546 & -236 & 84 \\ -364 & -154 & 51 \end{bmatrix} \]
We use eigenvals to find the eigenvalues of A.
> with(linalg):
> A:=matrix(3,3, [177, 77, -28, -546, -236, 84, -364, -154, 51]);
> eigenvals(A):
2, -5, -5
We see that A has two eigenvalues \( \lambda = 2 \) and \( \lambda = -5 \) (multiplicity 2). Now, let’s find a basis for each eigenspace using eigenvectors.
> eigenvectors(A):
\[ \begin{align*}
&[2, 1, [[1, -3, -2]]], \\
&[-5, 2, [[1, 0, 13/2], [0, 1, 11/4]]]
\end{align*} \]
We see that the eigenspace corresponding to \( \lambda = 2 \) is one-dimensional and that \( [[1, -3, -2]] \) is a basis. For \( \lambda = -5 \), the eigenspace is two-dimensional and a basis is \( [[1, 0, 13/2], [0, 1, 11/4]] \). Hence, we have found three independent eigenvectors and A is diagonalizable. So, we let
\[ P = \begin{bmatrix} 1 & 2 & 0 \\ -3 & 0 & 4 \\ -2 & 13 & 11 \end{bmatrix} \]

\( \Box \) gives repeated composition so that \( f^m(x) \) gives \( f(f(...f(x))) \) and \( f^{m+1}(x) \) gives \( f(f(...f(x))) \). For certain functions known to MAPLE v, \( f^m \{ -1 \} (x) \) gives the inverse function \( f^{-1}(x) \).

5.3 Summation and product

In MAPLE, the syntax for the sum
\[ \sum_{i=1}^{n} f(i) = f(1) + f(2) + \cdots + f(n) \]
is \texttt{Sum}(f(i), i=1..n) and \texttt{sum}(f(i), i=1..n).
> f := 'f';
> Sum(f(i), i=1..n);
\[ \sum_{i=1}^{n} f(i) \]
> Sum(i^2, i=1..10);
\[ \sum_{i=1}^{10} i^2 \]
> sum(i^2, i=1..10);
385
Notice that the difference between \texttt{sum} and \texttt{Sum} is that in \texttt{sum}, the sum is evaluated, but that in \texttt{Sum}, it is not. It is recommended that one get into the habit of using \texttt{Sum} to first check for types and then use \texttt{value} to evaluate the sum. In our previous session we found
\[ \sum_{i=1}^{10} i^2 = 1 + 4 + 9 + \cdots + 100 = 385. \]
This time we will use \texttt{Sum} and \texttt{value}.
> Sum(i^2, i=1..10);
\[ \sum_{i=1}^{10} i^2 \]
> value(sum);
385
> sum(i^2, i=1..n);
\[ 1/3 (n + 1)^3 - 1/2 (n + 1)^2 + 1/6 n + 1/6 \]
do not need to be an expert programmer to master it. You will appreciate the real power of \texttt{MAPLE V} when you learn some of the basic \texttt{MAPLE V} language and use it in combination with its interactive features. If you have gotten this far into the book, you are already familiar with many \texttt{MAPLE V} commands and the step to \texttt{MAPLE V} programming is not a big one.

8.1 Conditional statements

A conditional statement has the form

\begin{verbatim}
if condition then
  staseq
else
  staseq
fi;
\end{verbatim}

Here \texttt{staseq} is a sequence of statements separated by semi-colons (or colons). For example,

\begin{verbatim}
> x:=1;
  x := 1
> if x>0 then
>   y:=x+1
> else
>   y:=x-1
> fi;
> y;
  2
\end{verbatim}

This conditional statement means that if $x > 0$ then $y = x + 1$, but if $x \leq 0$ then $y = x - 1$. In the session $x = 1 > 0$ so $y = x + 1 = 2$.

8.2 Loops

A \texttt{loop} statement has the form

\begin{verbatim}
for var from num1 to num2 do
  staseq
od;
\end{verbatim}

For instance, we can print out the numbers from 1 to 10.

\begin{verbatim}
> for i from 1 to 10 do
>   print(i);
> od;
\end{verbatim}

4.6 Data conversions

The function \texttt{type} checks the data type of an object.

\begin{verbatim}
> A := {1, 2, 3};
> is := 1, 2, 3;
\end{verbatim}
We can also sum the integers from 1 to 10 the \textit{old-fashioned} way.

\begin{verbatim}
> x:=0;
> for i from 1 to 10 do
> x:=x+i;
> od;
> x;
\end{verbatim}

Hence the sum is 55. We can check our answer.

\begin{verbatim}
> 1+2+3+4+5+6+7+8+9+10;
\end{verbatim}

\begin{verbatim}
> \texttt{sum('i'='i'=1..10)};
\end{verbatim}

We can change the step-size in a loop by using by.

\begin{verbatim}
> for i from 2 by 3 to 20 do
> print(i);
> od;
\end{verbatim}

\subsection{Procedures}

A \textsc{maple v} \texttt{procedure} has the form

\begin{verbatim}
proc(nameseq)
local nameseq;
global nameseq;
slasseq;
end;
\end{verbatim}

The \texttt{local} and \texttt{global} statements are optional. See the next section. Here is an example.

\begin{verbatim}
> f:=proc(x)
> local z;
> if x>0 and x<1 then
> z:=-x^2;
> else
> z:=-1-x;
> fi;
> RETURN(z);
> end;
\end{verbatim}

\begin{verbatim}
> M[2..5];
\end{verbatim}

\begin{verbatim}
[2/3, 3/4, 4/5, 5/6]
\end{verbatim}

So, \texttt{M[i..j]} gives the \textit{i}-th through \textit{j}-th elements of the list \textit{M}.

\subsection{Tables}

In \textsc{maple v}, a \texttt{table} is an array of expressions whose indexing set is not necessarily a set of integers. Sounds bizarre? — let’s look at some examples. Tables are created by the \texttt{table} function.

\begin{verbatim}
> T := table([a,b]);
\end{verbatim}

\begin{verbatim}
T := table([
  1 = a,
  2 = b ])
\end{verbatim}

\begin{verbatim}
> T[2];
\end{verbatim}

\begin{verbatim}
b
\end{verbatim}

So, if \textit{L} is a list, then \texttt{table(L)} converts \textit{L} into a table. The \textit{j}-th element of this table \textit{T} is given by \texttt{T[j]}. Try

\begin{verbatim}
> S := table([i=A, (3-B+C, (5-A*B+C)]);
\end{verbatim}

\begin{verbatim}
> S[3];
\end{verbatim}

\begin{verbatim}
> S;
\end{verbatim}

\begin{verbatim}
> op(S);
\end{verbatim}

For the table \textit{S}, the indexing set is \{1, 3, 5\} and thus does not necessarily have to be a set of consecutive integers. See \texttt{?table} for more bizarre examples. In your session you should have found that \textit{S} did not return the table, but that \texttt{op(S)} did.

\subsection{Arrays}

In \textsc{maple v}, an \texttt{array} is a special kind of a table. It most resembles a matrix. Let’s look at some examples.

\begin{verbatim}
> A := array(1..2,1..3);
\end{verbatim}

\begin{verbatim}
A := array(1..2,1..3)
\end{verbatim}

\begin{verbatim}
> op(A);
\end{verbatim}

\begin{verbatim}
[ 1, 2, 3, 4, 5, 6, 7, 8, 9 ]
\end{verbatim}
4. Data Types

4.1 Sequences

In Maple V sequences take the form

\[ expr1, expr2, expr3, \ldots, exprn. \]

> \texttt{x := 1, 2, 3;}
  \texttt{x := 1, 2, 3}

> \texttt{y := 4, 5, 6;}
  \texttt{y := 4, 5, 6}

> \texttt{x,y;}
  \texttt{1, 2, 3, 4, 5, 6}

We observe that in Maple V, \( x, y \) concatenates the two sequences \( x \) and \( y \). There are two important functions used to construct sequences: \texttt{seq} and the repetition operator \$.

> \texttt{f := 'f';} \texttt{seq(f(i), i=1..6);}
  \texttt{f(1), f(2), f(3), f(4), f(5), f(6)}

> \texttt{seq(i^2, i=1..5);}
  \texttt{1, 4, 9, 16, 25}

> \texttt{x := 'x';}
  \texttt{x := 'x'}

> \texttt{x$3;}
  \texttt{x, x, x}

In general, \texttt{seq(f(i), i=1..n)} produces the sequence

\[ f(1), f(2), \ldots, f(n) \]

and \texttt{x$n} produces a sequence of length \( n \)

\[ x, x, \ldots, x \]

The \texttt{op} function can be used to create sequences.

> \texttt{b := 'b'; c := 'c';}
> \texttt{L := a+b+2*c+3*d;}
  \texttt{L := a + b + 2*c + 3*d}

> \texttt{op(L);}
  \texttt{a, b, 2*c, 3*d}

> \texttt{read trap;}

If your Maple V session was started in the same directory.

8.6 Viewing built-in Maple V code

One of the great features of Maple V is that most of the built-in functions are written in the Maple V programming language and the code is accessible to the user. To see how Maple V defines the Gamma function, try

> \texttt{interface(verbosity=proc=2);}
> \texttt{op(GAMMA);}

9. Saving and Reading Files

In Section 8.5 we saw that the Maple V read command may be used to read in programs in a Maple V session. In this chapter we examine the ways following may be saved and read: (1) variables, (2) sessions, and (3) worksheets. Also we will examine the different ways in which Maple V worksheets may be exported.

9.1 Saving a Maple session

A Maple V session may be saved through the File menu by selecting Save As... or by clicking on \texttt{\textdb{}}. The options are then Maple Worksheet, Maple Text, Text, and LaTeX Source. The default is Maple Worksheet. The file extension for a Maple worksheet is \texttt{.mw}. If you saved your session as \texttt{first.mw} then, in a later session, you may open this worksheet by selecting Open... or by clicking on \texttt{\textdb{}}. When this worksheet is open, the whole worksheet is visible but the values of variables have not been assigned. The values of variables may be saved using the \texttt{save} command.

> \texttt{x := 5;}
> \texttt{y := 7;}
> \texttt{z := int(1/u, u);}
> \texttt{save 'first.m';}
> \texttt{save x, y, part1;}

In the session above, all the variables were saved in the maple binary file \texttt{first.m}. The values of \( x \) and \( y \) were saved in the text file \texttt{part1}.

See \texttt{?open}, \texttt{?close}, \texttt{?append}, \texttt{?write}, and \texttt{?writedata} for other methods of writing to files.

9.2 Reading Maple V programs

See Section 8.5 on reading Maple V proc's. Maple V programs may be read in the same manner. An existing Maple V worksheet may be opened under the File menu by selecting Open... or by clicking on \texttt{\textdb{}}.
Text files and .m files may be read with the \texttt{read} command. We read two files created in the last section:

\begin{verbatim}
> read 'first.m';
> read part1;
\end{verbatim}

When \texttt{first.m} is read, the values of all the variables \( x \), \( y \), and \( z \) are assigned but not displayed. When the text file \texttt{part1} is read, the variables \( x \) and \( y \) are assigned their previous values and displayed.

See \texttt{?readdata}, \texttt{?readline}, and \texttt{?scanf} for reading data.

\subsection*{9.3 Saving worksheets and \LaTeX}

In Section 9.1 we saw how a Maple worksheet may be saved as a .mws file and opened in a later session. A worksheet may also be saved as a plain text or \LaTeX{} file. In the File menu, select \texttt{Export As} ... and then select either Plain Text ..., Maple Text ..., or \LaTeX{} ... To convert Maple output into \LaTeX{}, use the \texttt{latex} function. Try

\begin{verbatim}
> with(linalg):
> A:=matrix(3,3,(i,j)->sin(Pi*i*j/6));
> latex(A);
\end{verbatim}

\section*{10. Document preparation}

\texttt{Maple V} (Release 4) has many new features for creating documents. It is now possible to add Maple output to text and create technical documents. There are also facilities for adding headings, changing fonts, inserting expandable sub-sections, bookmarks, and hyperlinks.

We now demonstrate some of these features with a specific example. Suppose we have the following

\textbf{Problem.} Reduce the weight of a ball-bearing with diameter 2 cm by 50\% by drilling a hole through the center. Determine the diameter of the required drill-bit.

\textbf{This problem can be solved easily in \texttt{Maple V} by computing a certain integral and solving an equation. Start Maple and type in the following.}

\begin{verbatim}
> v:=Int(4*Pi*x*sqrt(1-x^2),x=0..1);
> v:=value(v);
> v:=value(v);
\end{verbatim}

\texttt{[}\texttt{1/3}\ \texttt{]}\texttt{[}\texttt{1} 3/\texttt{2}\ \texttt{]}\texttt{[}\texttt{4}\ \texttt{3}^\texttt{1/2}\ \texttt{]}

\begin{verbatim}
> ifactor(28743);  ifactor(552805);
\end{verbatim}

\begin{verbatim}
\begin{tabular}{c}
\{3\} [11] [67]
\{5\} [11] [19] [23]^2
\end{tabular}
\end{verbatim}

\begin{verbatim}
> lcm(21,35,99);
\end{verbatim}

\begin{verbatim}
3465
\end{verbatim}

We find that the gcd of 28743 and 552805 is 11. This can also be seen from the prime factorizations. The lcm of 21, 35 and 99 is 3465.

\subsection*{3.3.4 Primes}

The \texttt{i-th} prime can be computed with \texttt{ithprime}. The function \texttt{isprime} tests whether a given integer is prime or composite.

\begin{verbatim}
> ithprime(100);
\end{verbatim}

\begin{verbatim}
541
\end{verbatim}

\begin{verbatim}
> isprime(2^101-1);
f\texttt{alse}
\end{verbatim}

\begin{verbatim}
> 7*3^10 + 10;
\end{verbatim}

\begin{verbatim}
413353
\end{verbatim}

\begin{verbatim}
> isprime(n);
\end{verbatim}

\begin{verbatim}
true
\end{verbatim}

We found that the 100th prime is 541, that \( 2^{101} - 1 \) is composite, and that \( 7 \cdot 3^{10} + 10 = 413353 \) is prime.

\subsection*{3.3.5 Integer solutions}

In Sections 3.2.1 and 3.2.2 we saw how to solve equations in \texttt{Maple V} using \texttt{solve}. The integer analog of \texttt{solve} is \texttt{isolve}. We use this function if we are only interested in integer solutions. We use the example from Section 3.2.2. Remember to restore variable status to \( x \) and \( a \) first.

\begin{verbatim}
> x:=\texttt{}`\texttt{x}': \texttt{a:=`a'};
> eqn1:=x^3+4*x=14: eqn2 := a^2-x=7:
> isolve([eqn1,eqn2],[x,a]);
\end{verbatim}

\begin{verbatim}
\{a = 3, x = 2\}
\end{verbatim}

This time we found the unique integer solution \( a = 3, \ x = 2 \) to the given system of equations.
The command \texttt{subs(eqn)} gave us the left side of the equation. Then we were able to substitute \( x = R[1] \) (the first root) into the left side of the equation, which simplified to 1 as expected using \texttt{expand}.

### 3.2.2 Finding exact solutions

\texttt{maple v} has the capability for solving systems of equations.

\begin{verbatim}
> eqn1 := x^3+ax+14; eqn2 := a^2-x-7;
  eqn1 := \( x^3 + ax + 14 \)
  eqn2 := \( a^2 - x - 7 \)
>
> solve([eqn1, eqn2], [x, a]);
  \[ a = 3, x = 2 \],
  \[ a = \text{RootOf}(Z^3 + 3Z^4 - 12Z^3 - 35Z^2 + 42Z + 119), x = \text{RootOf}(Z^3 + 3Z^4 - 12Z^3 - 35Z^2 + 42Z + 119) \]
\end{verbatim}

The syntax for solving systems of equations is \texttt{solve(S,X)} where \( S \) is a set of equations and \( X \) is the required set of variables. Observe that \texttt{maple v} was able to find the solution \( x = 2, a = 3 \). It also found that \( a = z, x = z^2 - 7 \) are solutions where \( z \) is any root of the following polynomial equation:

\[ Z^5 + 3Z^4 - 12Z^3 - 35Z^2 + 42Z + 119 = 0. \]

As in the previous section, we may manipulate solutions. We select the first set of solutions and substitute them into the first equation.

\begin{verbatim}
> "[1];
  \[ a = 3, x = 2 \]
>
> subs("[1],eqn1);
  14 = 14
\end{verbatim}

### 3.2.3 Finding approximate solutions

In the last section we came upon the following quintic:

\[ Z^5 + 3Z^4 - 12Z^3 - 35Z^2 + 42Z + 119 = 0. \]

Although naturally enough \texttt{maple v} is unable to find an exact explicit solution, it is able to find approximate solutions using \texttt{fsolve}.

First we create a new region. Click on the vertical bar attached to \( \boxed{m} \) and click on \( \boxed{t} \) and then \( \boxed{t} \). There should now be a new text region below the new subsection. Now type:

\begin{verbatim}
> eq := \( \frac{-4}{3} \left(1 - r^2\right)^{3/2} \pi + \frac{4}{3} \pi \)
\end{verbatim}

Use the mouse or hot-keys to copy the selection and paste it to the right of the equal-sign. The hot-keys are system dependent. In Windows, use \texttt{control}-c to copy and \texttt{control}-v to paste. Observe how the displayed math has been converted to maple input. Now type a semicolon and press enter:

\begin{verbatim}
> eq := \( -4/3 \left(1 - x^2\right)^{3/2} \pi + 4/3 \pi \); 
\end{verbatim}

Now use the mouse to highlight the maple input line:

\begin{verbatim}
> eq := \( -4/3 \left(1 - x^2\right)^{3/2} \pi + 4/3 \pi \);
\end{verbatim}

and hit \texttt{control-z} (or \texttt{delete}) and this line should now be erased. Finally, add enough text and equations so that the document is complete. A rendition of how it might appear is given below.

### The Ball Bearing Problem

William E. Wilson

### Statement of the problem

Reduce the volume of a ball bearing with diameter 2 cm by 50\% by drilling a hole through the center. Determine the diameter of the required drill-bit.

### Solution

First we observe that the ball bearing is the solid obtained by rotating a circle of radius 1 cm about the \( y \)-axis. If we let \( r \) be the radius of the drill-bit then, by the shell method, the volume \( v \) of material removed is given by \( \int_0^1 4\pi x \sqrt{1-x^2} dx \). We compute the integral.

14
Computation

> \( v := \int (4 \pi x \sqrt{1 - x^2}) \, dx \);
> \[ v = \int_{0}^{1} 4 \pi x \sqrt{1 - x^2} \, dx \]

Our computation gave

\[ v = \frac{4}{3} \left( 1 - r^2 \right)^{3/2} \pi + \frac{4}{3} \pi \]

We solve the equation

\[ \frac{4}{3} \left( 1 - r^2 \right)^{3/2} \pi \quad \text{and} \quad \frac{4}{3} \pi = \frac{2}{3} \pi \]

Computation

to find that the required diameter is

\[ 2r = \sqrt{2 - 1/\sqrt{3}} \]

which is approximately 1.212 cm.

10.6 Bookmarks and hypertext

A bookmark is a name that marks a location in a worksheet. Selecting this name will move the cursor to the specified location. To create a bookmark at the last equation in our document, click the cursor on the equation. Then, in the View menu, select Bookmarks and then Edit Bookmark . . . An Add or Modify Bookmark window should appear. In the Bookmark Text box, type a word, say ANSWER and click on OK. Although the worksheet appears no different, it now has a single bookmark. We may access this bookmark by selecting Bookmarks in the View menu. Now ANSWER should appear in the submenu. Select ANSWER and the cursor will move to the specified location. Try moving the cursor to a different place in the worksheet and select ANSWER again.

Now we will use our bookmark to create a hyperlink in our worksheet. A hyperlink is a link from one location in the worksheet to a different location in the worksheet or to a different worksheet altogether. The presence of a hyperlink is indicated by green underlined text. Clicking on this text will move the cursor to the new location. In our worksheet we will attach a hyperlink from the word diameter in the statement of the problem to our bookmark ANSWER.

Move the cursor to the word diameter near the top of the worksheet and in the Insert menu select HyperLink . . . A HyperLink Properties window should appear. In the Link Text box, type diameter. Then click on \( \mathbf{A} \) near the Book Mark box and select ANSWER.
> readlib(rationalize):
> 1/(1+sqrt(2));
> rationalize(";
> (1-2^(2/3))/(1+2^(1/3));
> rationalize(";
> y := z/(1 + sqrt(x));
> rationalize(y);

Notice that rationalize does a great job rationalizing a denominator not only for expressions involving square roots but for more complicated radicals as well. It can also handle symbolic expressions.

3.1.6 Simplifying rational functions

To simplify a rational function (i.e., a function that can be written as a quotient of two polynomials) we use the command normal. This has the effect of cancelling any common factors between numerator and denominator. First we restore $x$ and $y$'s variable status.

$y := y';
\quad z := z';
\quad a := (x-y-z)*(x+y+z);
\quad a := (x-y-z)(x+y+z);
\quad b := (x^2 - 2xy - 2xz + y^2 + 2yz + z^2)
\quad * (x^2 + 2xy + 2xz + y^2 + 2yz + z^2);
\quad b := (x^2 - 2xy - 2xz + y^2 + 2yz + z^2)(x^2 - xy + xz - yz);
\quad c := a/b; normal(c);
\quad (x + y + z)
\quad (x^2 - yz + xz - yz)(-x + y + z)
glossary of commands

@ Function composition operator
SYNTAX: f@g
Gives the composition of the functions f and g.
EXAMPLE:
> (sin@cos)(x);

animate Animation of a 2-dimensional plot
SYNTAX: animate(F(x,t),x=a..b,t=c..d)
Animation of F(x,t) on the interval [a,b] with frames c \leq t \leq d.
EXAMPLE:
> with(plots):
> animate(sin(x+t),x=-10..10,t=1..2);

animate3d Animation of a 3-dimensional plot
SYNTAX: plot3d(F(x,y,t),x=a..b,y=c..d,t=p..q)
Animation of F(x,y,t) for a \leq x \leq b, c \leq y \leq d with frames c \leq t \leq d.
EXAMPLE:
> with(plots):
> animate3d(cos(x+y+t),x=0..Pi,y=0..Pi,t=1..2);

assign Assignment of solution sets
SYNTAX: assign(S)
Assign the variables given in the set S.
EXAMPLE:
> S:={y=-1,x=2}; assign(S); x,y;

asympt Asymptotic expansion
SYNTAX: asympt(f(x),x,n)
Gives the asymptotic expansion to order n of f(x) as x → ∞.

3.1.5 Simplifying radicals

To simplify expressions using radicals, we can use simplify and radnormal. First, we remove the assumption on x:
> y := (x-2)^2/2;
> assume(x>2);
y := \sqrt{(x-2)^2}
> simplify(y);
x := 2

This restores x to its original status. See Section 3.1.9.
> y := x^3 + 3x^2 + 3x + 1;
> assume(x>1);
> simplify(y^(1/3));
(1 + x)^(1/3)
> radnormal(y^(1/3));
1 + x
> assume(x<1);
> simplify(y^(1/3));
> assume(x<1);
> simplify(y^(1/3));
-1/2 (x^3 + 1) (1 + 3^{1/2})
> x := 'x';

Notice that simplify recognized y as a cube but failed to simplify y^{1/3}. The command radnormal, on the other hand, was able to simplify y^{1/3} to 1 + x. If assumptions are given for x, then simplify is able to simplify the radical further. However, it should be noted that the value of the cube root depends on these assumptions so care needs to be taken.

A useful Maple v command is rationalize. However, before using it, we must first use readlib to read it into memory. Most of Maple v's packages are automatically loaded when a maple session is started. Other functions in various packages (see Chapter 11) are read in using with. In addition, there are some functions that are only read in using readlib.
> evalf("; 0.726542573

Notice that evalf found \(\tan(\pi/3)\) to 10 decimal places which is the default. Also, note that in Maple \(\pi\) is represented by \(\Pi\). There are two ways to change the default and increase the number of decimal places.

> E := exp(1); evalf(E, 20);
\[
2.7182818284590452354
\]

> Digits := 30;
\[\text{Digits} := 30\]

> evalf(E);
\[
2.7182818284590452333008426766136
\]

Here \(E\) is the mathematical constant \(e\), which we have represented in Maple by \(\exp(1)\). We found \(e\) to 20 digits using \(\text{evalf}(E, 20)\). The other method is to use the global variable \(\text{Digits}\) (whose default value is 10). After assigning \(\text{Digits} := 30\), we found \(e\) correct to 30 digits simply by calling \(\text{evalf}(E)\). We reset the default and calculated \(\sin(\pi/6)\).

> Digits := 10;

> evalf(sin(Pi/6));
\[
0.500000000
\]

> convert(".rational");
\[\frac{1}{2}\]

Notice that after we found the decimal approximation, we were able to convert it into an exact rational using \(\text{convert(".rational")}\). The \(\text{convert}\) function is used to convert expressions from one type to another. More on the \(\text{convert}\) function is to be found in Section 4.6. The interested reader can find more using ?convert. Below is a table of Maple's built-in mathematical constants.

<table>
<thead>
<tr>
<th>Catalan</th>
<th>Catalan's constant</th>
</tr>
</thead>
<tbody>
<tr>
<td>(about .9159655942)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>gamma</th>
<th>Euler's constant</th>
</tr>
</thead>
<tbody>
<tr>
<td>(about 0.5772156649)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>I</th>
<th>complex number (i) ((i^2 = -1))</th>
</tr>
</thead>
</table>

| Pi | \(\pi\) (about 3.141592654) |

3. High School Algebra

3.1 Polynomials and rational functions

---

**Example:**

> expand((2*x+1)*(3*x-5));

\[
\text{factor} \quad \text{Factor a polynomial}
\]

**Syntax:** \(\text{factor}(p)\)

Factors the polynomial \(p\).

**Example:**

> factor(x^3+2x^2-2x^2-y^3);

**floor**

Greatest integer function

**Syntax:** \(\text{floor}(r)\)

Returns the greatest integer less than or equal to \(r\).

**Example:**

> floor(-11/3);

\[
\text{fsolve} \quad \text{Solve using floating-point arith.}
\]

**Syntax:** \(\text{fsolve}(\text{eqns, vars})\)

Finds an approximate solution to the given set of equations.

**Example:**

> fsolve(cos(x)=x/2, x);

**ifactor**

Prime factorization of an integer

**Syntax:** \(\text{ifactor}(n)\)

Computes the prime factorization of the integer \(n\).

**Example:**

> ifactor(999);

**implicitplot**

2-dim. plot of a function defined implicitly

**Syntax:** \(\text{implicitplot}(f(x,y)=c, x=a..b, y=c..d)\)

Plots the set of points \((x, y)\) satisfying \(f(x, y) = c\) in the indicated ranges.

**Example:**

> with(plots):

\[
\text{implicitplot}((x^2)^{(1/3)} + (y^2)^{(1/3)} = 1, x=-1..1, y=-1..1);
\]

**implicitplot3d**

3-dim. plot of a function defined implicitly

**Syntax:** \(\text{implicitplot3d}(f(x,y,z)=c, x=a..b, y=c..d, z=e..f)\)

Plots the set of points \((x, y, z)\) satisfying \(f(x, y, z) = c\) in the indicated ranges.
EXAMPLE:
> implicitplot3d(x^2+y^2+z^2=1, x=-1..1,
> y=-1..1, z=-1..1);

int        Compute an integral
SYNTAX:    int(f(x), x)
Computes \( \int f(x) \, dx \).

EXAMPLE:
> int(x^2/sqrt(1+x^2), x=1..sqrt(3));

isolve     Integer solutions to equations
SYNTAX:    isolve(eqn, var)
Finds integer solutions to the given set of equations (if they exist).

EXAMPLE:
> isolve([x^2+y^2=2, x^2+y^2=2], [x, y]);

latex      Convert to LaTeX
SYNTAX:    latex(expr)
Converts the expression into LaTeX.

EXAMPLE:
> latex(Int(1/x, x));

lhs        Left-hand side of an equation
SYNTAX:    lhs(eqn)
Gives the left-hand side of the given equation.

EXAMPLE:
> 0=x^2+2*y^2-2;  (lhs(0);

limit      Compute a limit
SYNTAX:    limit(f(x), x=a)
Computes the limit \( \lim_{x \to a} f(x) \).

EXAMPLE:
> limit((cos(x)-1)/x^2, x=0);

normal     Normalize a rational function
SYNTAX:    normal(expr)
Simplifies the expression by clearing common factors.

EXAMPLE:
> normal((1-q^7)*(1-q^6)/(1-q^7)/(1-q));

numer      Numerator of an expression

________________________________________________________________________

> 12^20;
383375999344747512176

The basic arithmetic operations in MAPLE V are

+        addition
-        subtraction
*        multiplication
^ or ** exponentialization
/        division

MAPLE V also has the basic mathematical functions (and much more) that are available on a scientific calculator.

abs(x)    absolute value  \( |x| \)
sqrt(x)   square root  \( \sqrt{x} \)
!         factorial
sin(x)    sine
cos(x)    cosine
tan(x)    tangent
sec(x)    secant
csc(x)    cosecant
cot(x)    cotangent
log(x)    natural logarithm
sinh(x)   hyperbolic sine
cosh(x)   hyperbolic cosine
tanh(x)   hyperbolic tangent

MAPLE V has many other built-in mathematical functions. For instance, it has the inverse trig functions (\texttt{arcsin}, \texttt{arccos}, etc.), the Bessel functions \texttt{BesselI}, the Riemann zeta function \texttt{Zeta}, the gamma function \texttt{GAMMA}, and the complete and incomplete elliptic integrals \texttt{EllipticE}. For a complete listing, see \texttt{?index[functions]}.  

2.2 Floating-point arithmetic

MAPLE V can do floating-point calculation to any required precision. This is done using \texttt{evalf}.

> tan(Pi/6);
\( \sqrt{3} - 2 \sqrt{2} \)
The next row is called the context bar and contains four buttons:

- **Toggle the expression display between mathematical and Maple notation.**
- **Toggle the expression display between word text and executable Maple command.**
- **Auto-correct the expression for syntax.**
- **Execute the current expression.**

The > prompt will be in the worksheet window. Don’t worry about the buttons too much at this stage.

### 1.2 Basic syntax

In Maple the prompt is the symbol >. Maple V commands are entered to the right of the prompt. Each command ends with either ";" or ";". If the colon is used, the command is executed but the output is not printed. When the semicolon is used, the output is printed. Try typing 105/25: followed by a return (or enter).

> 105/25:

Observe that the output was not printed. Now type 105/25;

> 105/25;

21/5

Try these

> 105/25-1/5;

4

> "+1/5;

21/5

> ";

4

Observe that Maple V uses exact arithmetic. The double quote character " refers to the previous result. The two double quotes "" refers to the result before the previous result. It is possible to refer back 3 lines using """, but one cannot refer back any further.

One of the most common mistakes is to omit the semicolon or colon:

> 105/25

Warning, incomplete statement or missing semicolon
1. Getting Started

1.1 Starting a Maple V session

In most systems a Maple V session is started by double clicking on the Maple V logo. Double clicking on the New User’s Tour icon gives you a brief introduction to Maple V and its worksheet environment. In the X Windows version, Maple V is started by entering the command maplev. In the text (tty) version, the Maple logo appears followed by the > prompt.

In most versions a window with menus will appear. At the top are the menus File, Edit, View, Format, Options, and Help. Beneath are two rows of buttons. The first row of buttons is called the tool bar and contains 19 buttons:

1. Create a new worksheet.
2. Open an existing worksheet.
3. Save the active worksheet.
4. Print the active worksheet.
5. Cut the selection to the clipboard.
6. Copy the selection to the clipboard.
7. Paste the clipboard contents into the current worksheet.
8. Undo the last deletion.
9. Insert Maple commands.
10. Insert text.
11. Insert a new maple input region after the cursor.
12. Convert the selected subsection into a section.
13. Convert the selection into a subsection.
15. Set magnification to 100%.
16. Set magnification to 150%.
17. Set magnification to 200%.
18. Display non-printing characters.
19. Resize the active window to fill the available space.


Maple and Calculus


Maple and Differential Equations


Maple and Linear Algebra


Maple, Science and Engineering


INTRODUCTION

Maple® is a very powerful interactive computer algebra system. It is used by students, educators, mathematicians, scientists, and engineers for doing numerical and symbolic computation. Maple has many strengths: (1) it can do exact integer computation, (2) it can do numerical computation to any (well almost) number of specified digits, (3) it can do symbolic computation, (4) it comes with many built-in functions and packages for doing a wide variety of mathematical tasks, (5) it has facilities for doing 2- and 3-dimensional plotting and animation, (6) it has a worksheet-based interface, (7) it has facilities for making technical documents, and (8) Maple is a simple programming language which means the user can easily write his/her own functions and packages.

The purpose of this book is to help you get started using the main features of Maple (Release 4), the latest version of Maple. It is not an exhaustive manual. The reader should consult the Maple reference books when the need arises. It is best to use this book while at the computer trying out commands, following examples, and experimenting as you read. This book should be a sufficient resource for students taking a class that uses Maple.

Maple itself has built-in help facilities. Help can be found either through the interactive Help menu or by using the ? command. For instance, a very short introduction to Maple can be found by typing ?int.

The table of contents is organized mainly according to mathematical topics starting with using Maple as a calculator, then doing high school algebra, calculus, and progressing to more sophisticated mathematics and programming. An important goal of this book is to show you how to write simple Maple programs (or procedures). When this goal is achieved, the reader should appreciate the power of Maple.

In Chapter 1 there is a brief introduction to the new Maple interface. The reader anxious to know more about Maple’s new document creating facilities can find detailed information in Chapter 10.

Maple is available on Windows, Macintosh, and UNIX platforms. The author would like to thank Waterloo Maple Inc. for permission to include pictures of the maple icons and buttons.

Frank Garvan [frank@math.ufl.edu]
Department of Mathematics, University of Florida, Gainesville, FL 32611-8105

Maple is a registered trademark of Waterloo Maple Inc., 450 Philip Street, Waterloo, Canada N2L 3G1, 1-800-267-4883, (519) 747-2073, Fax: (519) 747-2084, Email: info_web@maplesoft.com, Website: http://www.maplesoft.com.